Cisco Intelligent Automation for SAP 3.0
Installation Guide
Release 3.0
December, 2013

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
800 553-NETS (6387)
Fax: 408 527-0883

Text Part Number: OL-28278-01
CONTENTS

Preface vii
Audience vii
Organization viii
Conventions ix
Related Documentation x
Obtaining Documentation and Submitting a Service Request x

CHAPTER 1
Overview 1-1
  Automation Packs for SAP 1-1
  Installation and Configuration Process 1-2

CHAPTER 2
Planning and Preparing Environment 2-1
  Supported SAP Versions 2-2
  Required SAP Components 2-3
    SAP ABAP and Solution Manager Requirements 2-3
    SAP JAVA Requirements 2-4
    SAP HANA Requirements 2-6
  Reporting Database Sizing Requirements for SAP Environment 2-9
  SAP User Account Recommendations 2-10
    SAP User Account 2-10
    SAP Support User Account 2-10
  SAP System Information 2-11
    SAP ABAP System and Solution Manager Information 2-11
    SAP Java System Information 2-11
    SAP HANA System Information 2-12
    SAP BOBJ Information 2-13
  SAP Database Access Rights 2-14
    Microsoft SQL Server Windows Authentication 2-14
    SQL Server SQL Authentication 2-14
    Oracle Database Access Rights 2-16
    DB2 Database Access Rights 2-17
  Registering Process Orchestrator with SAP System Landscape Directory 2-17
    Pre-Registration Requirements 2-17
Manualy Registering Product 2-18
Importing Product Information 2-18
Transferring Product Information via XML 2-19
Configuring SAP Multi-Tenant Support in Web Console 2-19
Error Handling, Logging and Tracing for Cisco Add-On 2-20
   Error Handling 2-20
   SAP Standard RFC Tracing 2-20
   Log Entries 2-20
Support Desk Management for Cisco Add-On 2-20

CHAPTER 3
Installing Intelligent Automation for SAP 3-1
   Downloading and Running Installer 3-1
   Importing the Automation Packs for SAP 3-1
      Importing Automation Packs from Setup 3-3
      Importing Automation Packs from Console 3-3
   Installing Cisco Add-On File on SAP Systems 3-6

CHAPTER 4
Configuring SAP Targets and Runtime Users 4-1
   SAP Target and Runtime User Types 4-2
   Creating SAP System Targets 4-3
      Creating an SAP User Account 4-8
      Creating a Runtime User Account 4-9
   Creating SAP Solution Manager Targets 4-10
   Creating and Configuring HANA Targets 4-13
      Creating SAP HANA Database Target 4-13
      Creating Web Targets 4-14
      Creating Unix/Linux System Target 4-16
      Creating SAP System Target 4-19
   Creating SAP HANA target 4-20
      Configuring References to Targets 4-20
   Creating and Configuring SAP BOBJ DS Targets 4-22
      Creating an SAP BOBJ DS Target 4-22
      Creating Web Target 4-23
      Creating an SAP BOBJ DS Database Target 4-24
      Creating Unix/Linux Target 4-25
      Configuring References to Targets 4-25
   Creating and Configuring BOBJ XI Targets 4-26
      Creating BOBJ XI Service Target 4-26
Contents

Creating JMX Server Target 4-26
Creating Web Target 4-27
Configuring References to Targets 4-27

CHAPTER 5
Configuring Assignments and Notifications 5-1
Configuring SAP Default Assignment Task Rule 5-2
Creating a New Task Rule 5-3
Enabling Notification Based on Assignment Processes 5-7

CHAPTER 6
Configuring SAP Global Variables 6-1
Configuring Global Variables 6-1

INDEX
Preface

This preface includes the following sections:

- Audience
- Organization
- Conventions
- Related Documentation
- Obtaining Documentation and Submitting a Service Request

Audience

This guide is intended primarily for SAP administrators with responsibilities and expertise in one or more of the following areas:

- SAP Basis Administration
- IT System Administration
Organization

This document includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
<td>Overview</td>
<td>Contains an overview of Cisco Intelligent Automation for SAP.</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Planning and Preparing Environment</td>
<td>Contains information that is required to import and configure the objects included in the Automation Packs for SAP.</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Installing Intelligent Automation for SAP</td>
<td>Contains instructions for importing the SAP automation packs.</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Configuring Runtime Users</td>
<td>Provides information on configuring the runtime users to be used in the processes that run against your SAP environment.</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Configuring SAP Targets and Runtime Users</td>
<td>Provides instructions for creating and managing the SAP targets on which to run the processes.</td>
</tr>
<tr>
<td>Chapter 6</td>
<td>Configuring Assignments and Notifications</td>
<td>Provides instructions on using the Task Rules feature to configure assignments and notifications.</td>
</tr>
<tr>
<td>Chapter 7</td>
<td>Configuring SAP Global Variables</td>
<td>Provides information configuring the global variables that are used in the SAP processes.</td>
</tr>
</tbody>
</table>
## Conventions

This document uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>bold font</td>
<td>Commands and keywords and user-entered text appear in <strong>bold</strong> font.</td>
</tr>
<tr>
<td>italic font</td>
<td>Document titles, new or emphasized terms, and arguments for which you supply values are in <em>italic</em> font.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Elements in square brackets are optional.</td>
</tr>
<tr>
<td>{x</td>
<td>y</td>
</tr>
<tr>
<td>[x</td>
<td>y</td>
</tr>
<tr>
<td>string</td>
<td>A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.</td>
</tr>
<tr>
<td>courier font</td>
<td>Terminal sessions and information the system displays appear in <strong>courier</strong> font.</td>
</tr>
<tr>
<td>&lt; &gt;</td>
<td>Nonprinting characters such as passwords are in angle brackets.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Default responses to system prompts are in square brackets.</td>
</tr>
<tr>
<td>!, #</td>
<td>An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.</td>
</tr>
</tbody>
</table>

**Note**

Means *reader take note.*

**Tip**

Means *the following information will help you solve a problem.*

**Caution**

Means *reader be careful.* In this situation, you might perform an action that could result in equipment damage or loss of data.

**Timesaver**

Means *the described action saves time.* You can save time by performing the action described in the paragraph.

**Warning**

Means *reader be warned.* In this situation, you might perform an action that could result in bodily injury.
Related Documentation

Related documents for Cisco Process Orchestrator are available on Cisco.com at the following URL:

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see What’s New in Cisco Product Documentation at:

Subscribe to What’s New in Cisco Product Documentation, which lists all new and revised Cisco technical documentation, as an RSS feed and deliver content directly to your desktop using a reader application. The RSS feeds are a free service.
Overview

The Cisco Intelligent Automation for SAP solution consists of core features provided by Cisco Process Orchestrator and the Automation Packs for SAP. The solution standardizes, unifies, and automates best practices for IT processes in complex, heterogeneous environments. It helps companies shift from siloed and manual management to operational performance analysis and process automation across the data center.

While the Process Orchestrator platform provides users the enterprise context for IT process automation, the SAP automation packs are specifically designed to integrate with SAP Solution Manager, CCMS, and SAP HANA to automate SAP functions around incident response, task management, corrective actions and system copy activities.

The automation packs for SAP interface with SAP environments and include preconfigured SAP content, enabling users to automate incident response activities and orchestrate complex operational processes for SAP applications.

### Automation Packs for SAP

The Intelligent Automation for SAP solution includes the following automation packs:

<table>
<thead>
<tr>
<th>Automation Pack Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Automation for SAP</td>
<td>Contains content shared by other SAP dependent automation packs.</td>
</tr>
<tr>
<td>Core Automation for SAP BW, BOBJ and In-Memory Computing</td>
<td>Contains content share by the SAP BW, BOBJ and In-Memory computing automation packs.</td>
</tr>
<tr>
<td>Assessment for SAP BWA</td>
<td>Contains the content used to generate an assessment report to automate query evaluation and hardware sizing necessary for implementing SAP BWA.</td>
</tr>
<tr>
<td>Automation for SAP BW and BWA</td>
<td>Contains the content used to automate best practices for monitoring SAP BW and BWA availability, operations and performance.</td>
</tr>
<tr>
<td>Automation for SAP HANA</td>
<td>Contains the content used to provide intelligent automation, analysis, and corrective actions to support the operations, management, and maintenance of the SAP HANA database and its related technologies.</td>
</tr>
</tbody>
</table>
Chapter 1      Overview

Installation and Configuration Process

This guide provides instructions for downloading and installing the IA for SAP solution, importing the SAP automation packs, configuring the required extracted data, and configuring the objects in Process Orchestrator to run the processes. The configuration process includes the following tasks:

- Downloading and running the IA for SAP Solution Install Package
- Importing the SAP automation packs
- Adding SAP targets and runtime users for connecting to the targets
- Configuring global variables
- Setting up task rules for incident notifications
- Configuring Integration with HP Openview (Optional)
- Configuring Integration with Microsoft SCOM (Optional)

### Automation Pack Name | Description
--- | ---
Automation for SAP Solution Manager E2E Response | Contains the content used to automate analysis and problem resolution for incidents triggered by SAP Solution Manager alerts.
Incident Response for SAP | Contains the content used to automate best practices for identifying and analyzing availability and performance problems within your SAP environment. This includes event correlation and root cause analysis, and management of incoming incidents based on an analysis in the context of other incidents, events and metrics.
IT Task Automation for SAP | Contains the content to resolve incidents that are raised from the Incident Response for SAP processes.
Automation for SAP BOBJ Accelerator | Contains the content used to automate monitoring Business Objects XI Data Services content.
Automation for SAP BOBJ Enterprise | Contains the content used to automate system monitoring and corrective actions for Business Objects XI Data Services content.
Planning and Preparing Environment

This chapter provides information on the requirements and recommendations for installing and using the Intelligent Automation for SAP solution. The information in this chapter assumes that Process Orchestrator and the Core automation pack are already installed.

It includes the following sections:

- Supported SAP Versions, page 2-2
- Required SAP Components, page 2-3
- Reporting Database Sizing Requirements for SAP Environment, page 2-9
- SAP User Account Recommendations, page 2-10
- SAP System Information, page 2-11
- SAP Database Access Rights, page 2-14
- Registering Process Orchestrator with SAP System Landscape Directory, page 2-17
- Configuring SAP Multi-Tenant Support in Web Console, page 2-19
- Error Handling, Logging and Tracing for Cisco Add-On, page 2-20
- Support Desk Management for Cisco Add-On, page 2-20

Note

It is recommended that you verify your environment meets the minimum hardware and software requirements. See the Cisco Process Orchestrator Installation and Administration Guide for information on system requirements.
Supported SAP Versions

The following versions of SAP are supported by Process Orchestrator.

<table>
<thead>
<tr>
<th>SAP Application</th>
<th>Supported Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP R/3</td>
<td>• 4.7</td>
</tr>
<tr>
<td></td>
<td>• 6.10 (Support Package 6)</td>
</tr>
<tr>
<td></td>
<td>• 6.20 (including 4.7)</td>
</tr>
<tr>
<td></td>
<td>• 6.30</td>
</tr>
<tr>
<td></td>
<td>• 6.40</td>
</tr>
<tr>
<td></td>
<td>• 7.0</td>
</tr>
<tr>
<td></td>
<td>• 7.10</td>
</tr>
<tr>
<td></td>
<td>• 7.11</td>
</tr>
<tr>
<td></td>
<td>• 7.20</td>
</tr>
<tr>
<td></td>
<td>• 7.30</td>
</tr>
</tbody>
</table>

**Note**  To monitor Java portals on SAP v7.1x application servers, you must configure the JARM tracing service with custom values. See “Registering Process Orchestrator with SAP System Landscape Directory” section on page 2-17.

| SAP BW           | • 3.0 |
|                 | • 3.1 |
|                 | • 3.5 |
|                 | • 7.0 |
|                 | • 7.0 SP13 |
|                 | • 7.01 SP8 |
|                 | • 7.30 |

**Note**  RFCs that depend on the Process Orchestrator ABAP Transport files are only supported on SAP BW 7.00 SP16 or later.

BW remote function calls using the Cisco Add-on are supported on BW 7.01 SP8 or higher and BW 7.3.

| SAP BWA          | • 7.2 (Rev. 8 or later)—for BWA TREX Scripting |
| SAP Solution Manager | • SAP Solution Manager 7.1 SP05 or later |
|                 | – The SAP Solution Manager 7.1 system and basic setup must be completed. |
|                 | – Managed Objects must be configured. |
|                 | • SAP ABAP/Netweaver 7.02 SP10 |

**Note**  It is recommended that you install the latest kernel patch for the installed SAP version.
Note

It is recommended that Process Orchestrator be installed within a secure environment. The communication mechanisms that are used by Process Orchestrator are not currently configured to enable SAP Secure Network Communications (SAP SNC) or secure HTTP.

The communication that occurs between Process Orchestrator and the SAP system targets use one of the following technologies:

- SAP .NET Connector for RFC
- SAP JMX

Required SAP Components

This section provides information about the required SAP components to enable full functionality in Process Orchestrator. Refer to the appropriate section based on your SAP environment.

SAP ABAP and Solution Manager Requirements

SAP .NET Connector 3.0 for .NET 4.0 on x64 version 3.0.7.0 or higher must be installed and the following dll files copied to the Process Orchestrator server prior to configuring SAP ABAP system or SAP Solution Manager targets:

- sapnco.dll
- sapnco_utils.dll

See “Installing SAP .NET Connector Files” for instructions on installing these files.
Installing SAP .NET Connector Files

Perform the following steps to install the required SAP .NET Connector files.

**Note**  
SAP .NET Connector 3.0 for .NET 4.0 on x64 v3.0.7.0 or higher can be downloaded from the SAP website.

**Step 1**  
From the SAP .NET Connector 3.0 for .NET 4.0 on x64 program files folder on the server where NCo is installed, locate the following files:
- sapnco.dll
- sapnco_utils.dll

**Step 2**  
Copy the files to the following folder on the Process Orchestrator server:
<Install drive>:\Program Files\Cisco\Process Orchestrator\Adapters

**Step 3**  
Restart the Cisco Process Orchestrator Server service.

SAP JAVA Requirements

The following requirements must be met prior to installing SAP Java Application Server targets.

- SAP Java Library files must be installed on the Process Orchestrator server prior to configuring SAP Java Application Server targets. You must have access to one of the following SAP Installation CDs to install the files:
  - SAP NetWeaver 7.0 SR3  
    Java based Software Components  
    Number 51033513  
  - SAP NetWeaver CE 7.1 SR5  
    Java Components  
    Documentation  
    Developer Workplace  
    Number 51033845

  *See “Installing SAP Java Library Files” for instructions on installing the files.*

- JARM tracing service must be configured on SAP v7.1x systems if you want to monitor iView response time. *See “Configuring SAP v7.1x JARM Tracing Service”.*
Installing SAP Java Library Files

Perform the following steps to install the required SAP Java Library files.

**Step 1** Stop the *Cisco Process Orchestrator Server* service.

**Step 2** Go to Start > All Programs > Cisco > Cisco Process Orchestrator > SAP Libraries Install Wizard.

**Step 3** On the Welcome panel of the wizard, click *Next* to run the checker and determine whether the JMX libraries have been installed. The results of the checker display on the SAP Dependency Libraries Checker panel.

**Step 4** Click *Next* to continue. If the required files cannot be found, the SAP JMX Adapter Dependency Libraries Installer panel displays. Use this panel to specify the version of SAP that is installed and the location of the SAP installation files.

**Step 5** Check the check box next to the version of SAP that is installed (you can check both versions), and then enter the path or click the *Browse* tool to navigate to the location of the SAP installation files.

**Step 6** Click *Next* to install the files.

**Step 7** On the Finishing the SAP Libraries Install Wizard panel, verify that the files were successfully installed and then click *Close* to exit the installer.

**Step 8** Restart the *Process Orchestrator Server* service to complete the procedure.

Configuring SAP v7.1x JARM Tracing Service

Perform the following steps to configure the JARM tracing service on the SAP application server.

**Launch the SAP ConfigTool**

Perform the following steps to launch the SAP ConfigTool.

**Step 1** On the SAP server, navigate to the following directory:

```
usr\SAP\[SID]\J01\j2ee\configtool
```

**Step 2** Use one of the following methods to open the ConfigTool, depending on your operating system:

- In Windows, double-click the `configtool.bat` file.
- In UNIX, double-click the `configtool.sh` file.

**Step 3** On the Connection Settings dialog box, click *Yes* to use the default DB settings. The AS Java ConfigTool opens. Proceed to “Configuring Apptracing Properties”.
Configuring Apptracing Properties

Perform the following steps to configure the apptracing and monitor settings with custom values.

Step 1
In the navigation pane, navigate to cluster-data > template > instance > services and click apptracing.

Step 2
In the results pane, change the following properties by selecting the property name, entering the new value in the Custom value field and clicking Set.
- jarm/switch—On
- jarm/maxreqcomphigh—2600
- jarm/maxreqcomplow—2500

Step 3
In the navigation pane, navigate to cluster-data > template > instance > services and click monitor.

Step 4
In the results pane, click jarm_history.started.

Step 5
In the Custom value field, enter false and click Set.

Step 6
Click Save on the toolbar.

The Logs dialog box displays showing the changes that have been completed.

Step 7
Click OK and close the ConfigTool.

Step 8
Stop and restart the application server to complete the procedure.

SAP HANA Requirements

The following prerequisites must be met prior to configuring SAP HANA targets in Process Orchestrator.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA Database Client</td>
<td>The SAP HANA Database Client for Windows must be installed on the server where Process Orchestrator is installed. Download the SAP HANA CLIENT 1.00 (SP05 Revision 60 or later) for Windows on x64 64-bit from the SAP Service Marketplace.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The revision number of SAP HANA CLIENT 1.00 for Windows on x64 64-bit installed on the Process Orchestrator server must be the same as the revision number on the HANA database.</td>
</tr>
<tr>
<td></td>
<td>The minimum supported version for the SAP HANA Client 1.00 is SP05 Revision 60.</td>
</tr>
<tr>
<td>Configure Windows Host File</td>
<td>Before you can connect to the ODBC system DSN, you must add the HANA data source hostname and IP address to the Windows hosts file.</td>
</tr>
</tbody>
</table>
Chapter 2  Planning and Preparing Environment

Required SAP Components

Installing SAP HANA Database Client for Windows

The SAP HANA Database Client for Windows must be installed on the server where Process Orchestrator is installed. Download the SAP HANA CLIENT 1.00 (SP05 Revision 60 or later) for Windows on x64 64-bit from the SAP Service Marketplace.

Note

The revision number of SAP HANA CLIENT 1.00 for Windows on x64 64-bit installed on the Process Orchestrator server must be the same as the revision number on the HANA database.

The minimum supported version for the SAP HANA Client 1.00 is SP05 Revision 60.

Configuring Windows Host File and Path

Before you can connect to the ODBC system DSN, you must add the HANA data source hostname and IP address to the Windows hosts file.

Step 1  On the Cisco Prime Process Orchestrator server, navigate to the following location:
C:\Windows\System 32\drivers\etc\hosts

Step 2  Right-click the hosts file and open in Notepad.

Step 3  Enter the IP address and host name for the HANA host server (use the format suse-hana.xxx.domain.local) and press Enter on the keyboard.

Step 4  Click File > Save to save the file and complete the procedure.
Creating Data Source for ODBC System DSN

Before you can create HANA system targets, you must add the ODBC system data source used to connect to the HANA data provider from Process Orchestrator.

Step 1 In the Control Panel, double-click **Administrative Tools > Data Source (ODBC)**.

Step 2 On the ODBC Data Source Administrator dialog box, click the **System DSN** tab.

Step 3 Click **Add** to open the Create New Data Source dialog box.

Step 4 In the list of drivers, select **HDBODBC** and click **Finish**.

Step 5 On the SAP HDB dialog box, specify the following information:
- Data Source Name
- Description
- Server:Port

Step 6 Click **Connect**.

Step 7 On the SAP HDB Connection dialog box, enter the **User Name** and **Password** for connecting to the HANA Database and then click **OK**.

Unix/Linux Target Prerequisites

The following prerequisites must be met for Unix/Linux system target functionality:

- The following versions of Linux are supported:
  - SUSE Linux Enterprise 11 Service Pack 1
  - SUSE Linux Enterprise 11 Service Pack 2
- Linux performance monitoring requires that the SYSSTAT Linux package be installed. To install the package, run the command `yast -i sysstat`.
- If you want to monitor all Linux hosts, you must configure Auto-SSH login proxy. See Configuring Auto-SSH Login Proxy, page 4-19.
Reporting Database Sizing Requirements for SAP Environment

The formula for calculating the disk space for the Process Orchestrator Reporting database for an SAP environment is based on the following record statistics.

See the Cisco Process Orchestrator Installation and Administration Guide for disk space sizing formulas for environments other than SAP.

### Table 2-3 Calculating Disk Space Formula for Process Orchestrator Reporting Database for SAP Environment

| Incident Size | Alert Size | Event Size | Metric Size | Process Audit Size | Task Audit Size |
|---------------|------------|------------|-------------|--------------------|----------------|---|
| 60 KB/system/day x 1 system x 6 months = 10 MB | 400 KB/system/day x 1 system x 6 months = 72 MB | 2160 KB/application server/day x 5 servers x 6 months = 1920 MB | 1036 KB/application server/day x 5 servers x 6 months = 1864 MB | 600 KB/system/day x 1 system x 6 months = 108 MB | 90 KB/system/day x 1 system x 6 months = 16 MB |

The disk space requirements formula as shown in the following table is based on an environment that includes 1 SAP system with 5 application servers:

### Table 2-4 Calculating Disk Space Formula

<table>
<thead>
<tr>
<th>Data</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Size</td>
<td>60 KB/system/day x 1 system x 6 months = 10 MB</td>
</tr>
<tr>
<td>Alert Size</td>
<td>400 KB/system/day x 1 system x 6 months = 72 MB</td>
</tr>
<tr>
<td>Event</td>
<td>2160 KB/application server/day x 5 servers x 6 months = 1920 MB</td>
</tr>
<tr>
<td>Metrics</td>
<td>1036 KB/application server/day x 5 servers x 6 months = 1864 MB</td>
</tr>
<tr>
<td>Process Audit</td>
<td>600 KB/system/day x 1 system x 6 months = 108 MB</td>
</tr>
<tr>
<td>Task Audit</td>
<td>90 KB/system/day x 1 system x 6 months = 16 MB</td>
</tr>
<tr>
<td>Total Size</td>
<td>10 MB + 72 MB + 1920 MB + 1864 MB + 108 MB + 108 MB + 16 MB = 3.99 GB</td>
</tr>
</tbody>
</table>
SAP User Account Recommendations

This section provides recommendations for creating SAP user accounts.

SAP User Account

An SAP user account must be created for Process Orchestrator to log into SAP. Cisco recommends the user account is created with the following settings:

<table>
<thead>
<tr>
<th>Recommendation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required Authorization</td>
<td>S_A.System profile</td>
</tr>
<tr>
<td>Account Type</td>
<td>System, Service, or Communication user type is recommended</td>
</tr>
<tr>
<td>Language Setting</td>
<td>English, German. The Process Orchestrator server regional setting should match the language setting in SAP.</td>
</tr>
</tbody>
</table>

SAP Support User Account

The Process Orchestrator Auditor Role, which has read-only permissions, can be used for SAP support users to perform troubleshooting and maintenance tasks in Process Orchestrator. The default assignment of the Process Orchestrator Auditor Role is for the members of the Process Orchestrator Auditors group in Windows Computer Management.

Create the support user account and add it to the Process Orchestrator Auditors group in Windows Computer Management. Alternately, the created account may be directly assigned to the Process Orchestrator Auditor Role in Process Orchestrator.

For information on assigning support users to the Process Orchestrator Auditors security group, refer to the "Configuring Process Orchestrator Security” chapter in the Cisco Process Orchestrator Installation and Administration Guide.
**SAP System Information**

It is recommended that the following SAP system information be gathered prior to installing the SAP automation packs. This information will be required to create the SAP targets.

**SAP ABAP System and Solution Manager Information**

The following information is needed to create SAP ABAP System and Solution Manager targets.

<table>
<thead>
<tr>
<th>Connection Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name used to identify the SAP system</td>
</tr>
<tr>
<td>Application Server</td>
<td>Name or IP address for the ABAP application server</td>
</tr>
<tr>
<td>System Number</td>
<td>SAP-specific system number</td>
</tr>
<tr>
<td>SAP Router String (optional)</td>
<td>Used for SAP systems outside the firewall</td>
</tr>
<tr>
<td>Logon Information</td>
<td>User name, password and client for logging onto the SAP ABAP application server</td>
</tr>
<tr>
<td>Organization (optional)</td>
<td>Group or organization within the company that owns the target. For multiple SAP systems with the same SID, you must specify the organization for each SAP system target.</td>
</tr>
</tbody>
</table>

**Note**

Prior to creating an SAP Solution Manager target, you must have at least one managed object created and actively monitored in Solution Manager. Then, you can define an ABAP/JAVA system as a target. Simultaneously, you can define the SAP Solution Manager target.

**SAP Java System Information**

The following information is needed to create an SAP Java Application Server target.

<table>
<thead>
<tr>
<th>Connection Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server</td>
<td>Name or IP address for the Java application server</td>
</tr>
<tr>
<td>JMX Port</td>
<td>The JMX port number to connect to the Java application server. The following convention should be used for specifying the port number: 5&lt;J2EEinstance_number&gt;04</td>
</tr>
</tbody>
</table>

**Example:**

If your J2EE instance number is 15, the P4 port is 51504.
Table: SAP HANA System Information

<table>
<thead>
<tr>
<th>Target Type</th>
<th>Connection Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA Database Target</td>
<td>Host name or data source</td>
<td>Name of the server or data source where the HANA database resides.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;server name&gt;:port</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Port number will be 3XX15, where XX is the HANA System Number.</td>
</tr>
<tr>
<td></td>
<td>Database owner</td>
<td>Name of the database. For example, DH1.</td>
</tr>
<tr>
<td></td>
<td>Logon information</td>
<td>User name and password for connecting to the data source.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> The HANA User account created for Process Orchestrator should have the following authorizations: MONITORING HANA: This role authorizes the read monitoring activities. SESSION ADMIN: This role adds system privileges to the accounts to support the corrective actions in the content. These two authorizations cover all authorized content shipped in the automation pack for HANA.</td>
</tr>
<tr>
<td></td>
<td>Connection string</td>
<td>DSN connection string to the data source.</td>
</tr>
<tr>
<td>HANA Web Target</td>
<td>Base URL</td>
<td>Target URL to use as a base for the execution. For example: http://&lt;hanahostname&gt;:5XX13/?wsdl where XX=HANA System Number</td>
</tr>
<tr>
<td></td>
<td>Logon Information (Optional)</td>
<td>User credentials for connecting to the Web target, if required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> The user account should be a HANA OS SIDADM user.</td>
</tr>
</tbody>
</table>
Chapter 2      Planning and Preparing Environment

SAP System Information

The following information is needed to create SAP BOBJ DS and BOBJ XI targets.

<table>
<thead>
<tr>
<th>Target Type</th>
<th>Connection Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOBJ DS Web Target</td>
<td>Base URL</td>
<td>Target URL to use as a base for the execution.</td>
</tr>
<tr>
<td></td>
<td>Logon Information</td>
<td>User credentials for connecting to the Web target, if required.</td>
</tr>
<tr>
<td>BOBJ DS Database Target</td>
<td></td>
<td>See the online help for the type of database you are using.</td>
</tr>
<tr>
<td>BWA Unix/Linux Target</td>
<td>Host name</td>
<td>Host name or IP address of the server.</td>
</tr>
<tr>
<td></td>
<td>Port</td>
<td>Port number used to access the server.</td>
</tr>
<tr>
<td></td>
<td>Prompt prefix</td>
<td>Command prompt prefix used by the device type configurations and expects when issuing commands and connecting to the device.</td>
</tr>
<tr>
<td></td>
<td>Logon information</td>
<td>User name and password for connecting to the server.</td>
</tr>
</tbody>
</table>

SAP BOBJ Information

The following information is needed to create SAP BOBJ DS and BOBJ XI targets.

<table>
<thead>
<tr>
<th>Target Type</th>
<th>Connection Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HANA.SAP Administration</td>
<td>Host name</td>
<td>Host name or IP address of the server.</td>
</tr>
<tr>
<td>Unix Target</td>
<td>Port</td>
<td>Port number used to access the server.</td>
</tr>
<tr>
<td></td>
<td>Prompt prefix</td>
<td>Command prompt prefix used by the device type configurations and expects when issuing commands and connecting to the device.</td>
</tr>
<tr>
<td></td>
<td>Logon information</td>
<td>User name and password for connecting to the server.</td>
</tr>
</tbody>
</table>

**Note** The user account should be a HANA OS SIDADM user.

<table>
<thead>
<tr>
<th>Target Type</th>
<th>Connection Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HANA.Linux Administration</td>
<td>Host name</td>
<td>Host name or IP address of the server.</td>
</tr>
<tr>
<td>Unix Target</td>
<td>Port</td>
<td>Port number used to access the server.</td>
</tr>
<tr>
<td></td>
<td>Prompt prefix</td>
<td>Command prompt prefix used by the device type configurations and expects when issuing commands and connecting to the device.</td>
</tr>
<tr>
<td></td>
<td>Logon information</td>
<td>User name and password for connecting to the server.</td>
</tr>
</tbody>
</table>

**Note** The user account should be a Linux user with OS administration permissions.

**Note** Install a Linux/Unix adapter on the target OS or define a terminal adapter. The HANA OS level processes use the terminal adapter capabilities of the Linux/Unix adapter.
SAP Database Access Rights

These access rights are optional. If you want to collect SAP database SQL query information, you must have the following access rights to the SAP database.

Microsoft SQL Server Windows Authentication

If SQL Server Windows authentication is being used, the following access rights must be set on the machine where Process Orchestrator is installed. To change the connection settings through the database user configuration utility on Process Orchestrator server, the logged in user needs to have write permission to the Process Orchestrator installation folder.

- Windows Server 2003—The following user rights are required:
  - The user account that connects to the database must be assigned Logon as Service rights.
  - The user account that is logged in and using the user interface must be assigned Act as part of the OS rights.
- Windows Server 2008—The following user rights are required:
  - The user account that connects to the database must be assigned Logon as Service rights.
  - The user account that is logged in and using the user interface must be assigned Act as part of the OS rights.

SQL Server SQL Authentication

If SQL authentication is being used, the user account that connects to the database must have sysadmin (sa) rights on the machine where Process Orchestrator is installed. However, if the company requires a higher level of access than the standard sysadmin access, then use the following scripts to create the logon script for access.

Process Database Logon Script

Use the following logon SQL script to create the necessary credentials for accessing the Process Orchestrator processes database.

```sql
IF EXISTS (SELECT * FROM sys.server_principals WHERE name = N'Process Orchestratorprocess')
DROP LOGIN [Process Orchestratorprocess]
GO
```
CREATE LOGIN [Process Orchestratorprocess] WITH PASSWORD=N'Process Orchestrator',
DEFAULT_DATABASE=[Process OrchestratorProcess], CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
--For Windows authentication
--CREATE LOGIN [domain\userID] FROM WINDOWS WITH DEFAULT_DATABASE=[Process
OrchestratorProcess]
GO
USE [Process OrchestratorProcess]
GO
IF EXISTS (SELECT * FROM sys.database_principals WHERE name = N'Process
Orchestratorprocess')
DROP USER [Process Orchestratorprocess]
GO
DEFAULT_SCHEMA=[dbo]
GO
EXEC sp_addrolemember N'db_datareader', N'Process Orchestratorprocess'
GO
EXEC sp_addrolemember N'db_datawriter', N'Process Orchestratorprocess'
GO
**Reporting Database Authentication Script**

Use the following logon script to create a SQL user account for the Process Orchestrator reporting database. The assumption is that Process Orchestrator Reporting database will be created by a sysadmin account first, after which the script can be used to create a Process Orchestrator Reporting database account with limited permission, and change reporting database to use the Process Orchestrator Reporting user account.

```sql
IF EXISTS (SELECT * FROM sys.server_principals WHERE name = N'Process Orchestratorreporting')
DROP LOGIN [Process Orchestratorreporting]
GO
CREATE LOGIN [Process Orchestratorreporting] WITH PASSWORD=N'Process Orchestrator',
DEFAULT_DATABASE=[Process OrchestratorReporting], CHECK_EXPIRATION=OFF, CHECK_POLICY=OFF
--For Windows authentication
--CREATE LOGIN [domain\userID] FROM WINDOWS WITH DEFAULT_DATABASE=[Process OrchestratorReporting]
GO
USE [Process OrchestratorReporting]
GO
IF EXISTS (SELECT * FROM sys.database_principals WHERE name = N'Process Orchestratorreporting')
DROP USER [Process Orchestratorreporting]
GO
DEFAULT_SCHEMA=[dbo]
GO
EXEC sp_addrolemember N'db_datareader', N'Process Orchestratorreporting'
GO
EXEC sp_addrolemember N'db_datawriter', N'Process Orchestratorreporting'
GO
```

**Oracle Database Access Rights**

If you are using an Oracle database, it is recommended that the user account have *read* access rights to all tables and views assigned to it. The following minimum access rights must be assigned to the user account:

- SAP tables (SNAP and EDIDC)
- V$session
- V$rowcache
- V$librarycache
- Dbf_free_space
- Dbf_data_files
- V$lock
- V$sqlarea
- V$sql_plan
- V$sgastat
- all_objects
DB2 Database Access Rights

The following rights must be assigned to the user accounts for DB2 databases:

- The user account that connects to the DB2 UDB database must have SYSMON authority.

**Note**

After assigning the user account to the SYSMON group, the DB2 instance needs to be restarted to ensure that the privilege is active.

- The user account should have *Select* access on the following SAP tables:
  - SNAP
  - EDIDC

Registering Process Orchestrator with SAP System Landscape Directory

This section provides instructions for registering Process Orchestrator to the SAP System Landscape Directory (SLD). You can manually register the product, import the registration information or transfer the product information via XML file.

After installing Process Orchestrator, refer to the following paths:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Location:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default installation path</td>
<td>C:\Program Files\Cisco\Process Orchestrator</td>
</tr>
<tr>
<td>Default log/trace file path</td>
<td>C:\Documents and Settings[local user]\Local Settings\Application Data\Cisco\Process Orchestrator</td>
</tr>
<tr>
<td>Default configuration file</td>
<td>C:\Program Files\Cisco\Process Orchestrator\Configuration Data</td>
</tr>
</tbody>
</table>

Pre-Registration Requirements

Prior to registering the product with SLD, you must obtain the following information for the SLD server:

- Host—Name of the server hosting the SLD
- Port—Port number used for the server hosting the SLD
- User—User name assigned to the account logging onto the SLD (User must have a LcrInstanceWriterLD role.)
- Passwd—Password assigned to the user account logging onto the SLD
Manually Registering Product

You can manually register the product to the SLD by creating a product name/version and software component name/version in the software catalogue of the SLD.

Step 1 Log on to the SLD.

Step 2 Click Products > New Product Version and enter the following information:
  - Product name—Process Orchestrator
  - Vendor name—Cisco Systems Inc
  - Product version—V2.1

Step 3 Click Create.

Step 4 In the fourth empty field, enter the following information:
  - Technical name—CISCO_PROCESS_ORCHESTRATOR
  - Software component name—Cisco Process Orchestrator
  - Software component version—V2.1
  - Production state—released

Step 5 Click Create.

Importing Product Information

You can also import the product information to register it to the SLD.

Step 1 Log on to the SLD.

Step 2 Click Administration > Content > Import.

Step 3 In the Selected File field, enter the path to the SLD data zip file and then click Import Selected File.
Transferring Product Information via XML

You can also register the product information by transferring it via the XML file.

**Step 1**
Create the following folder to store the files:
C:\Example

**Step 2**
Copy the Test.class and the ThirdPartySystem.xml files into the folder.

**Step 3**
Enter the following command with the provided XML file:

```java
java -cp . example/Test SLD_host http_port user password ThirdPartySystem.xml
```

For example, enter the following:

```bash
C:\example>java -cp "././." example.Test iccsolman40.sap.com 80 3rd_party isvconnect08 ThirdPartySystem.xml
```

After running the command, Retcode:200 displays.

Configuring SAP Multi-Tenant Support in Web Console

When using the SAP multi-tenant feature and viewing the SAP systems in the Web Console, the organizations do not display by default. To view the organization column in the Task view, you must configure the WebConsole.config file to enable this column.

Perform the following procedure to modify the WebConsole.config file.

**Step 1**
On the Process Orchestrator server, navigate to the folder where the Web.config file is located. By default, the files are located in the following directory:

C:\Program Files\Cisco\Process Orchestrator\WebConsole

**Step 2**
Open the Web.config file in Notepad and navigate to the “AffectedOrganizations” setting.

```xml
name="AffectedOrganizations"
   enabled="false" />
```

**Step 3**
Change the enabled setting to true and then save the file to complete the procedure.
Error Handling, Logging and Tracing for Cisco Add-On

The Cisco Add-On contains API enabled ABAP function modules (RFC’s) that are called by Process Orchestrator. This is performed in Process Orchestrator by defining an ABAP adapter step and specifying a method for the SAP Target system in a process. The ABAP custom methods perform individual tasks such as updating RFC destinations and configuring printers.

Error Handling

In the event the method encounters an error, such as attempting to modify an RFC destination that does not exist, an error result is returned to the process. The activity that generated the error can be analyzed and actions can then be taken to resolve the issue that returned the error.

SAP Standard RFC Tracing

All RFC activity performed by Process Orchestrator may be traced through SAP Standard RFC tracing functionality. Refer to SAP online help for enabling the trace level for RFC communication on the SAP target system using SAP transaction SM59.

Log Entries

The SAP methods that are called may either write log entries to the SAP System Log (SAP Transaction SM21) or to the Application log (SAP Transaction SLG1) depending on the SAP standard application functionality. For instance, the SAP Application log is updated during the BDLS process scenario as this part of the SAP standard application functionality.

Support Desk Management for Cisco Add-On

SAP Root Cause Analysis ABAP tools can be used to review the performance and execution of the RFC calls performed by Process Orchestrator. A read-only SAP Administrator user is used to review the functionality performed by the ABAP methods. The following roles are to be the basis for a composite role that can be adapted to the customer environment:

- SAP_BC_BASIS_MONITORING,
- SAP_BC_SEC_USER_DISPLAY,
- SAP_BC_BTC_DISPLAY,
- SAP_BC_MID_ALE_DISPLAY
Installing Intelligent Automation for SAP

This chapter guides you through installing Intelligent Automation for SAP. It includes the following sections:

- Downloading and Running Installer, page 3-1
- Importing the Automation Packs for SAP, page 3-1
- Installing Cisco Add-On File on SAP Systems, page 3-6

Downloading and Running Installer

You must run the Intelligent Automation for SAP installer on the server where Process Orchestrator is installed. This will install the files to be imported into the Process Orchestrator console.

**Step 1**
From the installation CD, open the IA for SAP folder and double-click **Setup.exe** to launch the Intelligent Automation for SAP 3.0 Setup Wizard.

**Step 2**
Click **Next** on the Welcome panel to continue.

**Step 3**
Review the Readme file on the Information panel and then click **Next**.

**Step 4**
Click **Next** on the Confirm Installation panel to start the installation.

The Installation Complete panel displays the files that have been installed and the status (**Success**).

**Note**
The Launch automation pack import wizard now check box is checked by default. If you do not want to install the automation packs at this time, uncheck the box.

**Step 5**
Click **Close** to exit the installer.

Proceed to Importing the Automation Packs for SAP, page 3-1.

Importing the Automation Packs for SAP

You use the Automation Pack Import Wizard to import the automation packs. You can import the automation packs immediately after installing Process Orchestrator from the Setup wizard, or import them later from within the console.
The SAP automation packs have dependencies on other automation packs, and these automation packs must be installed first. The wizard guides you through importing each automation pack in the order of their dependency on other automation packs.

Refer to the information in Table 3-1 to determine the order in which the automation packs must be installed based on the dependencies.

**Table 3-1 SAP Automation Pack Dependency Information**

<table>
<thead>
<tr>
<th>Automation Pack Name</th>
<th>Dependent Automation Packs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Core Automation for SAP</td>
<td>Core</td>
</tr>
<tr>
<td>Core Automation for SAP BW, BOBJ and In-Memory Computing</td>
<td>Core</td>
</tr>
<tr>
<td>Assessment for SAP BWA</td>
<td>Core Automation for SAP</td>
</tr>
<tr>
<td>Automation for SAP BW and BWA</td>
<td>Core Automation for SAP BW, BOBJ and In-Memory Computing, Common Activities</td>
</tr>
<tr>
<td>Automation for SAP BOBJ Accelerator</td>
<td>Core Automation for SAP BW, BOBJ and In-Memory Computing, Common Activities</td>
</tr>
<tr>
<td>Automation for SAP BOBJ Enterprise</td>
<td>Core Automation for SAP BW, BOBJ and In-Memory Computing</td>
</tr>
<tr>
<td>Automation for SAP HANA</td>
<td>Common Activities, Core Automation for SAP, Core Automation for SAP BW, BOBJ and In-Memory Computing</td>
</tr>
<tr>
<td>Automation for SAP Solution Manager E2E Response</td>
<td>Core Automation for SAP</td>
</tr>
<tr>
<td>Incident Response for SAP</td>
<td>Core Automation for SAP</td>
</tr>
<tr>
<td>IT Task Automation for SAP</td>
<td>Common Activities, Core Automation for SAP</td>
</tr>
</tbody>
</table>
Importing Automation Packs from Setup

If you know which automation packs you want to import, and all prerequisites have been met, you can import them immediately after the Intelligent Automation for SAP installation completes.

**Step 1**  
After running the Setup wizard, ensure that the Launch automation pack import wizard now check box is checked before exiting the wizard.

**Step 2**  
On the Select Automation Packs dialog box, check the check boxes for the automation packs to be installed and then click OK to launch the Automation Pack Import Wizard.

**Note**  
If an automation pack has dependencies on other automation packs, the check box for the dependent automation packs will also be checked when you make your selection.

**Step 3**  
Proceed through the wizard to install each selected automation pack. See Running the Automation Pack Import Wizard, page 3-4.

Importing Automation Packs from Console

You can also use the Administration workspace in the Process Orchestrator console to access the Automation Pack Import Wizard. When you import the automation packs from the console, the Automation Pack File Selection dialog box guides you through selecting the automation packs and warns if there is a dependent automation pack required.

Selecting Automation Packs to Import

**Step 1**  
In the Administration workspace, select Automation Packs in the navigation pane and use one of the following methods to open the Automation Pack Files Selection dialog box:

- Right-click and select Import.
- Click the Actions menu and select Import.

**Step 2**  
On the Automation Pack Files Selection dialog box, click Add to open a list of available automation packs.

**Step 3**  
Select the automation packs to import and then click Open. Press the Ctrl key and click to select multiple automation packs.

The selected automation packs are added to the TAP File Names list. If a selected TAP file requires a dependent automation pack, a warning message displays similar to the following:

*The selected TAPs require some Automation Packs that have not been imported.*
Step 4  Perform one of the following steps to continue.

Dependent TAPs Required:

a. If dependent automation packs are required, click View Dependent TAPs to open the Automation Pack Dependencies dialog box.

b. Select the name of the automation pack and click Details to view a description of the dependency.

c. Note the name of the dependent automation pack(s) and click Close.

d. On the Automation Pack Files Selection dialog box, click Add, select the dependent automation pack, and then click Open to add it to the list of TAPs to be imported.

e. When the list is complete, click OK on the Automation Pack Files Selection dialog box.

No Dependent TAPs Required:

If no dependent automation packs are required, click OK on the Automation Pack Files Selection dialog box.

Running the Automation Pack Import Wizard

The Automation Pack Import Wizard guides you through importing the automation packs. When multiple automation packs are selected for import, the wizard will guide you through the panels for each automation pack, in order of dependency.

Perform the following steps to navigate through the Automation Pack Import Wizard.

Step 1  Click Next on the Welcome to the Automation Pack Import Wizard panel.

Note If you are importing multiple automation packs and you do not want the Welcome panel to display for each automation pack, check the Do not show this page next time check box.

General Information Panel

Step 2  Review the information about the automation pack and then click Next.

Default Incidents Assignee Setup Panel

The Default Incidents Assignee Setup panel displays if the automation pack provides for a default assignee for SAP-related incidents. Perform the following steps to specify the default user or group to assign incidents.

Note You can also skip this panel and specify the information later.

a. Click the Browse tool to open the Select User or Group dialog box.

b. Click Location and choose the location from which the user will be selected.

c. In the text box, enter the user name and click Check Names.

If the name is found, the box will be populated with the appropriate email address.

d. Click OK to close the Select User or Group dialog box.

Step 3  Click Next to continue.
Data Extraction Panel
The Data Extraction panel displays if the automation pack contains data that must be extracted to the Process Orchestrator server.

a. Accept the default destination for where the data will be extracted or specify a different destination. You can click the **Browse** tool to select the location.

b. In the Select data to extract area, verify that the check boxes are checked for the data that you want to extract. If you **do not** want to extract specific data, uncheck the check box.

You can extract the data at a later time from the Program Files folder.

**Step 4** Click **Next** to continue.

Review Prerequisites Panel
The Review Prerequisites panel displays the prerequisites for the automation pack.

- The green check mark indicates that the prerequisite was found on the computer.
- The red X indicates that the prerequisite was not found on the computer.

When this occurs, the import process stops and you will be prompted to close the wizard, install the prerequisite component, and then re-launch the wizard.

If all prerequisites are passed, the wizard automatically continues to import the objects contained in the automation pack.

**Step 5** After all automation pack objects have been imported, review the information on the Completing the Automation Pack Import Wizard panel to verify that it is correct and then click **Close** to close the wizard.
Installing Cisco Add-On File on SAP Systems

The SAP automation packs that contain processes that execute RFC calls on the SAP ABAP system targets, require that the Cisco Add-on file be installed on the SAP system targets where the RFCs will be executed. The file is extracted to the Process Orchestrator server when you import the automation pack.

Perform the following procedure to import the Cisco add-on file on all SAP System targets where the RFCs will be executed.

**Step 1** Navigate to the location where the ABAP Transport data was extracted for the SAP version of the systems in your environment. The locations are:

<table>
<thead>
<tr>
<th>Location</th>
<th>Folders</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Users[username]\Documents\Cisco\Cisco Process Orchestrator\Extracted Data\ABAP Transports\Solution Manager SP08\Add-on\</td>
<td>New Installation Upgrade</td>
</tr>
<tr>
<td>C:\Users[username]\Documents\Cisco\Cisco Process Orchestrator\Extracted Data\ABAP Transports\Solution Manager SP09 and Above\Add-on\</td>
<td>New Installation Upgrade</td>
</tr>
<tr>
<td>C:\Users\pnanjang\Documents\Cisco\Cisco Process Orchestrator\Extracted Data\ABAP Transports\Task Automation\Add-on\7.0 or 7.1 or 7.3</td>
<td>New Installation Upgrade</td>
</tr>
</tbody>
</table>

**Step 2** Copy the SAP Add-On Package file(s) to the following location on the SAP server:

usr\sap\trans\EPS\in

**Step 3** Log onto client 000 of the SAP system using an administrator account (DDIC or SAP* are not valid accounts) and run the SAP transaction code SAINT.

**Step 4** Follow the standard SAP procedures for performing an add-on product installation using SAINT.

**Step 5** Verify the installation was successful using the SAP menu path System > Status and reviewing the software component versions for the Cisco software component add-on.
Configuring SAP Targets and Runtime Users

Before you can create or run processes in your SAP environment, you must create the targets on which the processes will run. Targets are used to define specific environments where activities, triggers and processes will be executed. Use the Definitions—Targets view to define the targets.

When creating targets, a runtime user account must be specified to be used to connect to the target. The runtime user account stores the information about the user security context for the target. You can create the runtime user accounts during the process of creating the targets or prior to creating the targets using the Runtime Users workspace in the Console.

This chapter provides instructions for creating and managing the SAP targets. It includes the following sections:

- SAP Target and Runtime User Types, page 4-2
- Creating SAP System Targets, page 4-3
- Creating SAP Solution Manager Targets, page 4-10
- Creating and Configuring HANA Targets, page 4-13
- Creating and Configuring SAP BOBJ DS Targets, page 4-22
- Creating and Configuring BOBJ XI Targets, page 4-26
## SAP Target and Runtime User Types

The type of target that is required depends on the adapter that supports the automation pack. For the SAP-related automation packs, the following targets and corresponding runtime user account types are used:

<table>
<thead>
<tr>
<th>Target</th>
<th>Description</th>
<th>Runtime User Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System</td>
<td>Basic SAP system.</td>
<td>SAP User</td>
</tr>
<tr>
<td></td>
<td>SAP ABAP connection.</td>
<td>SAP User</td>
</tr>
<tr>
<td></td>
<td>SAP Java application server.</td>
<td>Runtime User</td>
</tr>
<tr>
<td></td>
<td>SAP database.</td>
<td>Runtime User</td>
</tr>
<tr>
<td>SAP Solution Manager</td>
<td>Connects to an SAP Solution Manager system.</td>
<td>SAP User</td>
</tr>
<tr>
<td>SAP HANA (Service target)</td>
<td>Use the service target to reference all the targets in the SAP HANA environment. The following targets are referenced in the HANA System target:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Generic Data Source (OLEDB)—database target</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Web Target</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Unix/Linux System Target</td>
<td></td>
</tr>
<tr>
<td>SAP BOBJ DS (Service target)</td>
<td>Use the service target type for the BOBJ DS environment. The following targets must also be created and referenced in the BOBJ DS Service target:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Web Target</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• BOBJ DS Database Target</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• BWA Unix/Linux target</td>
<td></td>
</tr>
<tr>
<td>SAP BOBJ XI (Service target)</td>
<td>Use the service target type for the BOBJ XI environment. The following targets must also be created and referenced in the BOBJ XI Service target:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• JMX Server Target</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Web Target</td>
<td></td>
</tr>
</tbody>
</table>
Creating SAP System Targets

This section guides you through creating SAP System targets. You can create a target for an SAP system that uses an ABAP connection to the application server, an ABAP and Java connection to the application server, or a Java connection to application server.

Note

The SAP ABAP and Java targets require that certain files be installed on the Process Orchestrator server prior to creating the targets. Refer to the following sections to ensure the prerequisite files are installed:

- Installing SAP .NET Connector Files, page 2-4
- Installing SAP Java Library Files, page 2-5

Note

Only one target for each SAP system can be created. For multi-tenant environments, you can create targets for different SAP systems but use the same system ID (SID).

When using the same SID for different SAP systems, you must enter the organization for each SAP system so Process Orchestrator can differentiate the alerts and incidents for each system.

The New SAP System wizard is used to create SAP system targets.

Step 1

On the Definitions workspace, right-click Targets and choose New > SAP System to open the Welcome to the New SAP System Wizard panel.

Step 2

Click Next to continue.

System Setup Panel

The System Setup panel displays for all types of SAP system targets. Use this panel to specify the system information for the target.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Enter a name for the SAP system. This is the name that will display in the Targets pane.</td>
</tr>
<tr>
<td>System Components</td>
<td></td>
</tr>
<tr>
<td>ABAP application servers</td>
<td>Check this check box if the SAP system uses an ABAP connection to the application server.</td>
</tr>
<tr>
<td>Java application servers</td>
<td>Check this check box if the SAP system uses a Java connection to the application server.</td>
</tr>
<tr>
<td>SAP database</td>
<td>Check this check box if you want to configure the SAP database that is associated with the SAP ABAP system.</td>
</tr>
</tbody>
</table>
### Creating SAP System Targets

#### Step 3

Click **Next** to continue.

**ABAP Connection Panel**

This panel displays if you are creating a target for an SAP ABAP system and is used to specify the connection information for the SAP ABAP system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor as production system</td>
<td>This check box is checked by default. Certain processes will run only on production systems. If you want to monitor the system as a non-production system (development or sandbox), uncheck the check box.</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter the group or organization within the company that owns the target.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you are configuring multiple SAP systems with the same SID, you must specify the organization for each SAP system target.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect using</td>
<td>Choose the connection method from the drop-down list. The fields that display on the panel depend on the connection method selected.</td>
</tr>
</tbody>
</table>
| Application server     | Choose this option to connect to the SAP system using the SAP application server connection information. Specify the information in the following fields:  
  - Server name—Enter the name of the SAP application server.  
  - System number—Enter the SAP system number. |
| Logon group            | Choose this option to establish a connection using a logon group, which contains a group of SAP system instances. When a user logs on to a logon group, the message server directs the users to the server of this group that currently has the lightest load. Specify the information in the following fields:  
  - System ID—Enter the SAP system ID (SID).  
  - Message server—Enter the name of the server a user logs on to that handles the communication between the application servers. For example, transport of update requests and lock requests.  
  - Group name—Enter the name of the Logon Group to be accessed. The name entered in this field is case-sensitive. |
Creating SAP System Targets

---

**Step 4**

Click **Next** to continue.

**Server Availability Panel**

This panel displays if you are creating a target for an SAP ABAP system. The Server Availability panel is used to specify the SAP application servers that you want to monitor for availability and the ability to log in a user.

All detected servers are checked by default.

a. Verify the check box next to each server to be monitored is checked.

b. Perform the following tasks to add or remove a server from the list:
   - If a server is offline during configuration, it will not be displayed in the list of available servers.
     
     To manually add the server, click **Add** and enter the name of the server.
   
   - If you want to remove a server from the list, select the server and click **Remove**.

**Step 5**

Click **Next** to continue.

**Database Connection Panel**

If you are configuring an SAP database, the Database Connection panel displays.

a. Choose the Database type from the drop-down list to display the fields for the specific type of database.

b. Specify the information for the type of database that is being configured. The fields that display depend on the database type.

---

### Field | Description
--- | ---
Router string (optional) | Enter the router string for accessing the SAP systems via SAPRouter. If you do not specify a router string, Process Orchestrator accesses the SAP system directly.

The router string must be formatted as:

/\(H/host01/H/host02/H/\)

where host01 and host02 are the SAP systems that you want to access through the SAPRouter.

Default runtime user | Choose the user account that contains the credentials to connect to the target from the drop-down list.

- To view the properties for the selected runtime user, click the **Properties** tool.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SQL Server Database</strong></td>
<td></td>
</tr>
<tr>
<td>Server</td>
<td>Enter the name of the SAP application server where the database resides.</td>
</tr>
<tr>
<td>Database name</td>
<td>Enter the name of the SAP database that is associated with the SAP system.</td>
</tr>
<tr>
<td>Database owner</td>
<td>Enter the name of the user that owns the rights to the database.</td>
</tr>
</tbody>
</table>
Creating SAP System Targets

Step 6 Click Next to continue.

---

**Field** | **Description**
--- | ---

**Oracle Database**

Hostname | Click this radio button to specify the information for connecting to the database using the server host name or IP address.

- SID—System ID for the server where the Oracle database resides.
- Port Number—Enter the port number used to connect to the database.

RAC via TNS | Click this radio button to connect to an Oracle RAC cluster using the TNS alias.

Enter the *tnsname* for the data source in the text field.

*Note* For additional information on using this option, see the Oracle Adapter online help.

Database owner | Enter the name of the user that owns the rights to the database.

**Generic Data Source (OLEDB)**

Hostname or data source | Name of the host server or data source for the Generic database.

Database owner | Enter the name of the user that owns the rights to the database.

**Common Fields for all Databases**

Default timeout for activities (seconds) | Enter the number of seconds before the activity times out. The default timeout period is 120 seconds.

Default runtime user | Choose the user account that contains the credentials to connect to the database from the drop-down list.

- To view the properties for the selected runtime user, click the **Properties** tool.
- To create a new runtime user, click **New > Runtime User**.

Connection string | If the database has a custom connection string label appended to the name, check the check box and modify the string in the text field.
Java Connection Panel

This panel displays if you are creating a target for an SAP Java application server. If the application server is already configured, it displays in the list box and you can continue to the next panel in the wizard. If the server is not listed, perform the following steps to add the server:

a. Click **New** to open the New SAP Java Application Server Wizard.

b. Enter a display name and description for the server on the General Information panel, and then click **Next** to continue.

   The JMX Connection panel displays. You connect to the Java application server using a JMX connection. You can also configure to connect to the application server using a Telnet connection.

c. Specify the connection information for the Java application server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server</td>
<td>Enter the IP address or name of the SAP Java application server.</td>
</tr>
<tr>
<td>JMX Connection</td>
<td></td>
</tr>
<tr>
<td>JMX port</td>
<td>Enter the JMX port number used to connect to the Java application server.</td>
</tr>
<tr>
<td>Use credentials of the following runtime user</td>
<td>Choose the default runtime user that contains the credentials to connect to the target from the drop-down list.</td>
</tr>
<tr>
<td>Note</td>
<td>The runtime user must be a J2EE Admin account.</td>
</tr>
<tr>
<td></td>
<td>To view the properties for the selected runtime user, click the Properties tool.</td>
</tr>
<tr>
<td></td>
<td>To create a new runtime user, click <strong>New &gt; Runtime User.</strong> See <strong>Creating a Runtime User Account,</strong> page 4-9.</td>
</tr>
<tr>
<td>Monitor as Portal</td>
<td>Check the check box to run processes designed for portals on this Java server.</td>
</tr>
<tr>
<td>Central Instance</td>
<td>Check the check box to run processes designed for central instances on this Java server.</td>
</tr>
<tr>
<td>Enable Telnet connection</td>
<td>Check this check box if you want to specify the Telnet connection information to connect to the Java application server.</td>
</tr>
</tbody>
</table>

d. Click **Next** to continue.

   If you enabled the Telnet Connection, the Telnet Connection panel displays.
e. Specify the Telnet connection information for connecting to the Java application server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telnet port</td>
<td>Enter the Telnet port number used to connect to the Java application server.</td>
</tr>
<tr>
<td>Use credentials of the following runtime user</td>
<td>Choose the default runtime user that contains the credentials to connect to the target from the drop-down list.</td>
</tr>
</tbody>
</table>

Note: The runtime user must be a J2EE Admin account.
- To view the properties for the selected runtime user, click the **Properties** tool.
- To create a new runtime user, click **New > Runtime User**. See **Creating a Runtime User Account**, page 4-9.

f. Click **Next** to continue.


g. Verify that the information is correct on the Completing the New SAP Java Application Server Wizard panel, and then click **Finish** to add the SAP Java application server on the Java Connection panel.

**Step 7** Click **Next** on the Java Connection panel.

**Step 8** Verify that the information is correct on the Completing the New SAP System Wizard panel, and then click **Finish** to complete the procedure.

The newly added SAP targets display in the Targets pane.

Creating an SAP User Account

The SAP User is the runtime user account type that connects to an SAP ABAP application server, SAP system, or SAP Solution Manager target.

**Step 1** Use one of the following methods to open the New SAP User Properties dialog box:
- When configuring a target, click **New > SAP User** in the Default runtime user field.
- In the Definitions workspace, right-click **Runtime Users** and choose **New > SAP User**.

**Step 2** On the General tab, specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name for the user account.</td>
</tr>
<tr>
<td>User name</td>
<td>User name assigned to the SAP user account that connects to the SAP system or ABAP application server.</td>
</tr>
<tr>
<td>Password</td>
<td>Password assigned to the SAP user account that connects to the SAP system or ABAP application server.</td>
</tr>
<tr>
<td>Client</td>
<td>SAP client number assigned to the user account.</td>
</tr>
<tr>
<td>Description</td>
<td><em>Optional.</em> A description of the user account.</td>
</tr>
</tbody>
</table>
Creating a Runtime User Account

The Runtime User is the runtime user account type that will be used to connect to an SAP Java application server, SAP database, or SAP BI Warehouse server target.

Step 1
Use one of the following methods to open the New SAP User Properties dialog box:
- When configuring a target, click New > Runtime User in the Default runtime user field.
- In the Definitions workspace, right-click Runtime Users and choose New > Runtime User.

Step 2
On the General tab, specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name for the user account. This field can be populated with the information specified in the Domain and User name text fields, or you can enter a different name to display for the user account.</td>
</tr>
<tr>
<td>User name</td>
<td>User name assigned to the user account that connects to the SAP target.</td>
</tr>
</tbody>
</table>
| Password      | Check the check box and enter the password assigned to the user account.  
**Note** No password verification is done for the simple (generic) runtime user. |
| Description   | Optional. A description of the user account. |

Step 3
Click **OK** to close the dialog box.
Creating SAP Solution Manager Targets

This section guides you through creating an SAP Solution Manager target.

---

**Note**

The SAP Solution Manager target requires that certain files be installed on the Process Orchestrator server prior to creating the target. Refer to Installing SAP .NET Connector Files, page 2-4 to ensure the prerequisite files are installed.

---

**Note**

When you create an SAP Solution Manager target, you must map the SAP systems that are monitored in Solution Manager to the SAP System targets configured in Process Orchestrator. Therefore, you must create SAP System targets in Process Orchestrator for the systems that are monitored in Solution Manager prior to creating an SAP Solution Manager target. See Creating SAP System Targets, page 4-3.

The following prerequisites must be met before you create the SAP Solution Manager targets:

- Managed objects must be configured in the Solution Manager for monitoring.
- The SAP Solution Manager Adapter requires the Cisco Add-On file to be installed on SAP Solution Manager.
- At least one SAP system target must be created that is monitored by Solution Manager.

You use the New SAP Solution Manager wizard to create SAP Solution Manager targets.

---

**Step 1**

On the Definitions workspace, right-click **Targets** and choose **New > SAP Solution Manager** to open the New SAP Solution Manager wizard.

**Step 2**

Click **Next** to continue.

**System Setup Panel**

Use the System Setup panel to specify the system information for the target:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Enter a name for the SAP Solution Manager system. This is the name that will display in the Targets pane.</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter the group or organization within the company that owns the target.</td>
</tr>
</tbody>
</table>

**Step 3**

Click **Next** to continue.
### Connection Panel

Use the Connection panel to specify the information required to connect to the SAP Solution Manager target:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect using</td>
<td>Choose the connection method from the drop-down list. The fields that display on the panel depend on the connection method selected.</td>
</tr>
</tbody>
</table>
| Application server         | Choose this option to connect to the SAP Solution Manager target using the SAP application server connection information. Specify the information in the following fields:  
  - Server name—Enter the name of the SAP Solution Manager application server (for example, sap-sol.xxx.domain.local).  
  - System number—Enter the SAP Solution Manager system number. |
| Logon group                | Choose this option to establish a connection using a logon group, which contains a group of SAP Solution Manager system instances. When a user logs on to a logon group, the message server directs the users to the server of this group that currently has the lightest load. Specify the information in the following fields:  
  - System ID—Enter the SAP Solution Manager system ID (SID).  
  - Message server—Enter the name of the server a user logs on to and that handles the communication between the application servers. For example, transport of update requests and lock requests.  
  - Group name—Enter the name of the Logon Group to be accessed. The name entered in this field is case-sensitive. |
| Router string (optional)   | Enter the router string for accessing the SAP Solution Manager systems via SAPRouter. If you do not specify a router string, Process Orchestrator accesses the SAP Solution Manager system directly. The router string must be formatted as: /H/host01/H/host02/H/  
  where host01 and host02 are the SAP Solution Manager systems that you want to access through the SAPRouter. |
| Default runtime user       | Choose the user account that contains the credentials to connect to the target from the drop-down list.  
  - To view the properties for the selected runtime user, click the **Properties** tool.  
Step 4  Click Next to continue.

Options Panel
Use this panel to specify polling intervals and to map the systems that are being monitored by the Solution Manager target to the SAP System targets configured in Process Orchestrator. The list box displays the systems that are mapped.

Note  The matching SAP System targets must already be created in Process Orchestrator.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poll Solution Manager alert not older than</td>
<td>Specify the value (in minutes, hours or days) to indicate which SAP Solution Manager alerts to retrieve. Any alerts older than the specified value will be ignored.</td>
</tr>
<tr>
<td>Select a system monitored by Solution Manager</td>
<td>Choose the SAP system that is monitored by Solution Manager from the drop-down list.</td>
</tr>
<tr>
<td>Select a matching system monitored by Process Orchestrator</td>
<td>Choose the SAP system target that is configured in Process Orchestrator from the drop-down list. This target must already be defined in Process Orchestrator.</td>
</tr>
<tr>
<td>Add to List</td>
<td>Click this button to add the mapped configuration to the list of systems to be monitored.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click this button to refresh the list of systems to be monitored.</td>
</tr>
</tbody>
</table>

Step 5  Click Next to continue.

Step 6  Verify that the information is correct on the Completing the New SAP Solution Manager Wizard panel, and then click Finish to complete the procedure.

The SAP Solution Manager target displays in the Targets pane.
Creating and Configuring HANA Targets

The Automation for SAP HANA automation pack includes a SAP HANA target template that can be used to create a service target for the HANA environment. The service target will hold the reference to all of the connections to HANA that are needed for automation.

Before you can reference the connections in the SAP HANA target, you must create the targets that will be referenced (Web target, Linux/Unix targets, Database target, SAP System target). After you create these targets, you create a unique SAP HANA target using the template and reference them.

This section guides you through creating the targets in the HANA environment, creating a HANA System system target using the template, and then referencing the target using the Target Properties feature.

Creating SAP HANA Database Target

You must create a database target for the SAP HANA database using the Generic Data Source (OLEDB) target type. Use the New Generic Data Source (OLEDB) Properties dialog box to create the database target.

Step 1
On the Definitions workspace, right-click Targets and choose New > Generic Data Source (OLEDB) to open the New Generic Data Source (OLEDB) Properties dialog box.

Step 2
On the General tab, specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name for the target. This is the name that will display in the Targets pane.</td>
</tr>
<tr>
<td>Owner</td>
<td>User name of the owner of the target. This is typically the person who created the target.</td>
</tr>
<tr>
<td>Organization</td>
<td>Name of the group or organization within the company that owns the target.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional. Information that describes the target.</td>
</tr>
</tbody>
</table>

Step 3
Click the Connection tab and specify the following connection information for the target:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hostname or Datasource</td>
<td>Name of the server or data source where the HANA database resides. Enter the information in the following format:</td>
</tr>
<tr>
<td></td>
<td>&lt;server name&gt;:port</td>
</tr>
<tr>
<td>Note</td>
<td>Port number will be 3XX15, where XX is the HANA System Number.</td>
</tr>
<tr>
<td>Database Owner</td>
<td>Principal owner of the database.</td>
</tr>
<tr>
<td>Default time out for activities (seconds)</td>
<td>Length of time to wait before a command is complete.</td>
</tr>
</tbody>
</table>
Chapter 4      Configuring SAP Targets and Runtime Users

Creating Web Targets

If you want to configure Process Orchestrator to monitor the Web targets in your HANA environment, you must create a Web target using the using the New Web Target Properties dialog box.

### Step 1
On the Definitions workspace, right-click **Targets** and choose **New > Web Target** to open the New Web Target Properties dialog box.

### Step 2
On the General tab, enter the information in the following text fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name for the target. This is the name that will display in the Targets pane.</td>
</tr>
<tr>
<td>Owner</td>
<td>User name of the owner of the target. This is typically the person who created the target.</td>
</tr>
</tbody>
</table>
Step 3 Click the **Connection** tab and then specify the following connection information for the target:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Name of the group or organization within the company that owns the target.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional. A description for the target.</td>
</tr>
</tbody>
</table>

**Base Url**

Enter the appropriate target URL to use as a base for the execution. For example:

http://<hanahostname>:5XX13/?wsdl

where XX=HANA System Number

**Runtime User**

Click one of the following radio buttons to indicate which runtime user account to use to connect to the target:

- No runtime user—Click this radio button to indicate that no runtime user is required to execute a process or activity against the target.
- Default runtime user—Click this radio button and then choose the default runtime user account that contains the credentials to connect to the target.

**Note** To view the properties for the selected runtime user, click the **Properties** tool.

To create a new runtime user account, click **New** and then choose **Runtime User**. See Creating a Runtime User Account, page 4-9.

**Note** The runtime user for this target should be the HANA OS SIDADM user.

**Ignore certificate errors**

Check or uncheck the check box to indicate whether the target should ignore any certificate errors on the specified web site. If the check box is checked, all errors will be ignored.

Step 4 Click **OK** to close the dialog box and complete the procedure.
Creating Unix/Linux System Target

If you want to monitor the HANA Linux systems in your environment, you must create the Unix/Linux System targets. The Automation for SAP HANA content requires that two different Unix/Linux System targets be created with different runtime user accounts:

- **HANA.SAP Administration Unix Target**—This target is used for SAP command line applications and uses the HANA OS SIDADM runtime user account.
- **HANA.Linux Administration Unix Target**—This target is used for LINUX command line administration applications and uses a Linux user with OS administration permissions as the runtime user account.

**Note**

If you want to monitor all Linux hosts, you must configure Auto-SSH login proxy. See Configuring Auto-SSH Login Proxy, page 4-19.

**Step 1**

On the Definitions workspace, right-click **Targets** and choose **New > Unix/Linux System** to open the New Unix/Linux System Properties dialog box.

**Step 2**

On the General tab, specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Enter a name for the Database target. This is the name that will display in the Targets pane.</td>
</tr>
<tr>
<td>Owner</td>
<td>User name of the owner of the target. This is typically the person who created the target.</td>
</tr>
<tr>
<td>Organization</td>
<td>Name of the group or organization within the company that owns the target.</td>
</tr>
<tr>
<td>Description</td>
<td><em>Optional</em>. A description for the target.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Check or uncheck the check box to enable or disable the target. The check box is checked by default.</td>
</tr>
</tbody>
</table>

**Step 3**

Click the **Connection** tab and then specify the connection information to connect to the Unix/Linux server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host name</td>
<td>Host name or IP address of server.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number used to access the server.</td>
</tr>
</tbody>
</table>
### Chapter 4  Configuring SAP Targets and Runtime Users

#### Creating and Configuring HANA Targets

**Prompt prefix**

Enter the command prompt prefix that will be used by the device type configurations and expects when issuing commands and connecting to the device.

Adding a regex character, such as $, >, and #, at the end of a prompt in the Prompt Prefix field invalidates the command prompt prefix.

Regular expressions should be placed in the appropriate Terminal Interaction Pattern fields.

**Example:**

Unix system prompt prefix is defined by the user default login script. It usually contains username, node name or current directory name. If the user does not define anything, the prompt prefix is empty.

If you connect to the terminal, and the prompt is `j smith@TBD-SH03-IT ~$`, enter the regular expression that will match the entire prefix (before #) using any of the following expressions:

- `.TBD-SH03-IT.*`
- `\[\w+@TBD-SH03-IT.*\]`

**Default runtime user**

Choose the default runtime user account that contains the credentials to connect to the target from the drop-down list.

To view the properties for the selected runtime user, click the **Properties** tool.

To create a new runtime user account, click **New > [Runtime User Type]** to create a new Runtime User account. See **Creating a Runtime User Account**, page 4-3.

**Note**

The runtime user for this target should be the HANA OS SIDADM user.

**Enable code injection prevention**

Check this check box to enable the protection which prevents code that is injected to exploit the security vulnerability.

**Maximum allowed concurrent sessions**

Enter the maximum allowed open sessions to run concurrently (default value is 3).

If the user tries to open a new session via Open Session activity, it will wait in a queue until there is a session available to open.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt prefix</td>
<td>Enter the command prompt prefix that will be used by the device type</td>
</tr>
<tr>
<td></td>
<td>configurations and expects when issuing commands and connecting to the</td>
</tr>
<tr>
<td></td>
<td>device.</td>
</tr>
<tr>
<td></td>
<td>Adding a regex character, such as $, &gt;, and #, at the end of a prompt in</td>
</tr>
<tr>
<td></td>
<td>the Prompt Prefix field invalidates the command prompt prefix.</td>
</tr>
<tr>
<td></td>
<td>Regular expressions should be placed in the appropriate Terminal</td>
</tr>
<tr>
<td></td>
<td>Interaction Pattern fields.</td>
</tr>
<tr>
<td><strong>Example:</strong></td>
<td>Unix system prompt prefix is defined by the user default login script.</td>
</tr>
<tr>
<td></td>
<td>It usually contains username, node name or current directory name. If the</td>
</tr>
<tr>
<td></td>
<td>user does not define anything, the prompt prefix is empty.</td>
</tr>
<tr>
<td></td>
<td>If you connect to the terminal, and the prompt is <code>j smith@TBD-SH03-IT ~$</code>,</td>
</tr>
<tr>
<td></td>
<td>enter the regular expression that will match the entire prefix (before #)</td>
</tr>
<tr>
<td></td>
<td>using any of the following expressions:</td>
</tr>
<tr>
<td></td>
<td>- <code>.TBD-SH03-IT.*</code></td>
</tr>
<tr>
<td></td>
<td>- <code>\[\w+@TBD-SH03-IT.*\]</code></td>
</tr>
<tr>
<td>Default runtime user</td>
<td>Choose the default runtime user account that contains the credentials to</td>
</tr>
<tr>
<td></td>
<td>connect to the target from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>To view the properties for the selected runtime user, click the <strong>Properties</strong> tool.</td>
</tr>
<tr>
<td></td>
<td>To create a new runtime user account, click <strong>New &gt; [Runtime User Type]</strong></td>
</tr>
<tr>
<td></td>
<td>to create a new Runtime User account. See <strong>Creating a Runtime User Account</strong>, page 4-3.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The runtime user for this target should be the HANA OS SIDADM user.</td>
</tr>
<tr>
<td>Enable code injection prevention</td>
<td>Check this check box to enable the protection which prevents code that is injected to exploit the security vulnerability.</td>
</tr>
<tr>
<td>Maximum allowed concurrent sessions</td>
<td>Enter the maximum allowed open sessions to run concurrently (default value is 3).</td>
</tr>
<tr>
<td></td>
<td>If the user tries to open a new session via Open Session activity, it will</td>
</tr>
<tr>
<td></td>
<td>wait in a queue until there is a session available to open.</td>
</tr>
</tbody>
</table>
Step 4  Click the **Authentication** tab to and specify the following information to indicate whether the target should allow authentication based on the host system:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use host-based authentication</td>
<td>Check this check box to indicate that host-based authentication will be used with this target. If this check box is unchecked, then host-based authentication will not be used.</td>
</tr>
<tr>
<td>Use the default host keys</td>
<td>This check box becomes enabled after the <em>Use host-based authentication</em> check box is checked. Check this check box to indicate the host keys defined on the Terminal Adapter property page will be used for this target. If this check box is unchecked, then the user will need to load the appropriate private key to be used to validate this target.</td>
</tr>
<tr>
<td>Private key</td>
<td>This box becomes enabled only if the <em>Use the default host keys</em> check box is unchecked. To the right of the <em>display-only</em> field, click the <strong>Browse</strong> tool to launch the Load Private Key dialog box and select a private key.</td>
</tr>
</tbody>
</table>

Step 5  Click the **Advanced** tab and specify the interaction patterns for the target.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use patterns common for the following device</td>
<td>Click the radio button <em>one</em> of the pre-defined device targets from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• Cisco IOS Device—Select this option to use the default pattern values used by the device during the completion of a session command.</td>
</tr>
<tr>
<td></td>
<td>• Unix/Linux System—Select this option to use the default pattern values indicated for a Unix or Linux system during the completion of a session command.</td>
</tr>
<tr>
<td></td>
<td>To view the properties for the selected device, click the <strong>Properties</strong> tool.</td>
</tr>
<tr>
<td></td>
<td>To create a new device, click <strong>New &gt; Expect Template</strong> to create a new expect template.</td>
</tr>
<tr>
<td>Customize patterns for this target</td>
<td>Select this radio button to enable the display-only sections in order to customize the default values for the selected device type.</td>
</tr>
</tbody>
</table>

Step 6  Click **OK** to close the dialog box and complete the procedure.
Configuring Auto-SSH Login Proxy

If you want to monitor all Linux hosts in your environment, you must configure an Auto-SSH login proxy.

---

**Note**

If you choose not to set up auto login proxy, only the Process Orchestrator Linux system target will be monitored.

---

**Step 1**

Create a Linux user with permissions for the following Linux commands:

- top
- iostat
- mpstat
- vmstat
- df

**Step 2**

Perform SSH login to the HANA Unix/Linux system target configured in Process Orchestrator using the Linux user account created in Step 1.

**Step 3**

Execute the command `ssh-keygen -t rsa`.

a. Enter passphrase as empty.

b. Note the file location of the key.

**Step 4**

Execute the command `ssh-copy-id -i <file path to key> < remote host>` and replace the `<remote host>` with the hostname for all HANA hosts in the instance.

**Step 5**

Test the remote connection by executing the command `ssh <remote host>` and confirm that you are no longer prompted for a password.

**Step 6**

In Cisco Prime Process Orchestrator, enter the new Linux user name in the target property *HANA.Linux Configuration* (HANA Linux Shell User column).

Creating SAP System Target

If you want to use the Landscape Transformation (LT) processes, you must create the SAP System (ABAP) targets for the LT replication servers that replicate data into HANA. The SAP System Wizard is used to create these targets.

See *Creating SAP System Targets, page 4-3* for instructions on creating the SAP System (ABAP) targets.
Creating SAP HANA target

Use the HANA System template to create the SAP HANA target specific to your environment. This system target will reference the HANA web target, database target, Unix target, and SAP System target. If you want to rename the template target, you must create a copy of the HANA System template target and then rename it prior to configuring the target properties.

Note

If you do not want to rename the HANA System template target, proceed to Configuring References to Targets, page 4-20

Configuring References to Targets

You must now configure the HANA System target to reference the Web target, Unix target and Database target. Use the Target Properties feature to reference the targets.

Creating Reference to HANA Database Target

Use this procedure to reference the HANA Database target that was created in “Creating SAP HANA Database Target” section on page 4-13.

Step 1  On the Definitions workspace, click Targets.
Step 2  Right-click the SAP HANA target and choose Properties.
Step 3  On the [SAP HANA Target] Properties dialog box, click the HANA Connections tab.
Step 4  Click the Browse tool next to the value field.
Step 5  On the Select Target dialog box, select the Database Target property and click OK to add the system to the value field.
Step 6  Click OK to close the SAP HANA Target Properties dialog box.

Creating Reference to HANA Web Target

Use this procedure to reference the HANA Database target that was created in “Creating Web Targets” section on page 4-14.

Step 1  On the Definitions workspace, click Targets.
Step 2  Right-click the SAP HANA target and choose Properties.
Step 3  On the [SAP HANA Target] Properties dialog box, click the HANA Connections tab.
Step 4  Click the Browse tool next to the value field.
Step 5  On the Select Target dialog box, select the Web Target property and click OK to add the system to the value field.
Creating Reference to HANA Unix Target

Use this procedure to reference the HANA Unix target that was created in “Creating Unix/Linux System Target” section on page 4-16.

Step 1 On the Definitions workspace, click **Targets**.
Step 2 Right-click the **SAP HANA** target and choose **Properties**.
Step 3 On the [SAP HANA Target] Properties dialog box, click the **HANA Connections** tab.
Step 4 Click the **Browse** tool next to the value field.
Step 5 On the Select Target dialog box, select the **SAP Administration Unix Target** property and click **OK** to add the system to the value field.
Step 6 Click **OK** to close the SAP HANA Target Properties dialog box.
Creating Reference to HANA ABAP Target

Use this procedure to reference the HANA ABAP target that was created in “Creating SAP System Target” section on page 4-19.

Step 1  On the Definitions workspace, click Targets.
Step 2  Right-click the SAP HANA target and choose Properties.
Step 3  On the [SAP HANA Target] Properties dialog box, click the HANA Connections tab.
Step 4  Click the Browse tool next to the value field.
Step 5  On the Select Target dialog box, select the ABAP Target property and click OK to add the system to the value field.
Step 6  Click OK to close the SAP HANA Target Properties dialog box.

Creating and Configuring SAP BOBJ DS Targets

The Automation for SAP BOBJ Accelerator automation pack includes a BOBJ DS Target Template that can be used to create service targets for the BOBJ DS environment. The service target will hold the reference to all of the connections to BOBJ DS that are needed for automation. Once the service target is created, you then create the Web and Database targets, and reference them in the BOBJ DS service target using the Target Properties feature.

In addition, you must create a BWA Unix/Linux target if you want to use the BWA TREX atomic processes that are included in the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack.

This section guides you through creating the targets and then configuring the target properties.

Creating an SAP BOBJ DS Target

Use the BOBJ DS Target Template as a basis for creating a BOBJ DS service target specific to your environment. You must first create a copy of the template target and then rename it.

Step 1  On the Definitions workspace, click Targets.
Step 2  Right-click the BOBJ DS Target Template target and choose Copy from the shortcut menu, and then right-click in a white area of the Targets pane and choose Paste.
Step 3  Right-click Copy of BOBJ DS Target Template and choose Properties.
Step 4  On the General tab, enter a name for the BOBJ DS target in the Display name text field.
Step 5  Click OK to save the target and close the dialog box.
Step 6  In the Targets pane, right-click the newly created BOBJ DS target and choose Enable to enable the target.
Creating Web Target

To monitor the BOBJ DS server, you need to a Web target and then reference it in the BOBJ DS service target properties.

Use the New Web Target Properties dialog box to create the Web target.

**Step 1**
On the Definitions workspace, right-click **Targets** and choose **New > Web Target** to open the New Web Target Properties dialog box.

**Step 2**
On the General tab, enter a name for the Web target in the Display name text field.

**Step 3**
Click the **Connection** tab and then specify the connection information for the target:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Url</td>
<td>Enter the appropriate target URL to use as a base for the execution. For example, <a href="http://doc-bobj-xidev.domain.local:8080/BOE/CMC">http://doc-bobj-xidev.domain.local:8080/BOE/CMC</a></td>
</tr>
<tr>
<td>Runtime User</td>
<td>Click one of the following radio buttons to indicate which runtime user account to use to connect to the target:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• No runtime user—Select this radio button to indicate that no runtime user is required to execute a process or activity against the target.</td>
</tr>
<tr>
<td></td>
<td>• Default runtime user—Select this radio button and then choose the default runtime user account that contains the credentials to connect to the target.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> To view the properties for the selected runtime user, click the <strong>Properties</strong> tool.</td>
</tr>
<tr>
<td></td>
<td>To create a new runtime user account, click <strong>New</strong> and then choose <strong>Runtime User</strong> or <strong>Windows User</strong>. See <strong>Creating a Runtime User Account</strong>, page 4-9.</td>
</tr>
<tr>
<td>Ignore certificate errors</td>
<td>Check or uncheck the check box to indicate whether the target should ignore any certificate errors on the specified web site. If the check box is checked, all errors will be ignored.</td>
</tr>
</tbody>
</table>

**Step 4**
Click **OK** to close the dialog box and complete the procedure.

The Web target displays in the Targets pane.
Creating an SAP BOBJ DS Database Target

Use the New Database Properties dialog box to create the BOBJ DS Database target.

**Note**
The screens in this section will differ depending on the type of database you are creating. See the online help for additional information on creating database targets.

**Step 1**
On the Definitions workspace, right-click **Targets** and choose **New > [Database Type]** to open the New Database Properties dialog box.

**Step 2**
On the General tab, enter a name for the database target in the Display name text field.

**Step 3**
Click the **Connection** tab and then specify the connection information for the database.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Name or the IP address for the database server.</td>
</tr>
<tr>
<td>Database name</td>
<td>Name of the database.</td>
</tr>
<tr>
<td>Database owner</td>
<td>Principal owner of the database.</td>
</tr>
<tr>
<td>Default timeout for activities (seconds)</td>
<td>Length of time to wait before a command is complete.</td>
</tr>
</tbody>
</table>
| Default runtime user         | Choose the user account that contains the credentials to connect to the target from the drop-down list.  
  • To view the properties for the selected runtime user, click the **Properties** tool.  
  • To create a new Runtime User, click **New > Runtime User.** See Creating a Runtime User Account, page 4-9. |
| Connection string            | Check the check box to enter the connection string for connecting to the database. |

**Step 4**
Click **OK** to close the dialog box.

The database target displays in the Targets pane.
Creating Unix/Linux Target

If you want to run the BWA TREX atomic processes that are included in the Core Automation for SAP BW, BOBJ and In-Memory Computing automation pack, you must create the BWA Unix/Linux System target.

See Creating Unix/Linux System Target, page 4-16 for instructions about creating the Unix/Linux target.

Configuring References to Targets

You must now configure the BOBJ DS target to reference the Web target and Database target. Use the Target Properties feature to reference the targets.

Creating Reference to BOBJ DS Web Target

Step 1  On the Definitions workspace, click Targets.
Step 2  Right-click the BOBJ DS target and choose Properties.
Step 3  On the BOBJ DS Service Target Properties dialog box, click the BOBJ DS tab.
Step 4  Select the BOBJ DS Web Target property and click Edit.
Step 5  On the Target Property Value dialog box, click the Browse tool next to the Value field.
Step 6  On the Select Target dialog box, select the BOBJ DS Web target and click OK.
Step 7  If you have completed adding target references, click OK to close the BOBJ DS Target Properties dialog box.

Creating Reference to BOBJ DS Database Target

Step 1  On the Definitions workspace, click Targets.
Step 2  Right-click the BOBJ DS target and choose Properties.
Step 3  On the BOBJ DS Service Target Properties dialog box, click the BOBJ DS tab.
Step 4  Select the BOBJ DS Database Target property and click Edit.
Step 5  On the Target Property Value dialog box, click the Browse tool next to the Value field.
Step 6  On the Select Target dialog box, select the Web target and click OK.
Step 7  Click OK to close the Target Property Value dialog box.
Step 8  If you have completed adding target references, click OK to close the BOBJ DS Target Properties dialog box.
Creating and Configuring BOBJ XI Targets

The Automation for SAP BOBJ Enterprise automation pack includes a BOBJ XI Service Target Template that can be used to create a service target the BOBJ XI environment. The system target will hold the reference to all of the connections to BOBJ XI that are needed for automation. Once the service target is created, you then create the JMX Server and Web targets, and reference them in the BOBJ XI service target using the Target Properties feature.

This section guides you through creating the targets and then configuring the target properties.

Creating BOBJ XI Service Target

Use the BOBJ XI Service Target Template as a basis for creating a BOBJ XI service target specific to your environment. You must first create a copy of the template target and then rename it.

**Step 1**
On the Definitions workspace, click **Targets**.

**Step 2**
Right-click the **BOBJ XI Target Template** target and choose **Copy** from the shortcut menu, and then right-click in a white area of the Targets pane and choose **Paste**.

**Step 3**
Right-click **Copy of BOBJ XI Target Template** and choose **Properties**.

**Step 4**
In the Display name text field, enter a name for the BOBJ XI target.

**Step 5**
Click **OK** to save the target and close the dialog box.

**Step 6**
In the Targets pane, right-click the newly created BOBJ XI target and choose **Enable** to enable the target.

Creating JMX Server Target

Use the New JMX Server Wizard to create JMX Server targets.

**Step 1**
On the Definitions workspace, right-click **Targets** and choose **New > JMX Server** to open the New JMX Server Wizard.

**Step 2**
On the General Information panel, enter a Display name and description for the target, and then click **Next** to continue.

**Step 3**
On the JMX Server Connection panel, specify the connection information for connecting to the JMX server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server</td>
<td>Enter the name or the IP address for the JMX server.</td>
</tr>
<tr>
<td>JMX port</td>
<td>Enter the port number used to connect to the JMX server.</td>
</tr>
<tr>
<td>Transport protocol</td>
<td>The Sun RMI protocol is the default protocol used for connecting to a standard MBean server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> This is the only option available and is selected by default.</td>
</tr>
</tbody>
</table>
Chapter 4  Configuring SAP Targets and Runtime Users

Creating and Configuring BOBJ XI Targets

Creating and Configuring BOBJ XI Targets

Creating and Configuring BOBJ XI Targets

## Step 4
Click Next to continue.

## Step 5
Verify that the information is correct on the Completing the New JMX Server Wizard panel, and then click Finish to complete the procedure.

The JMX Server displays in the Targets pane.

### Step 4
Click Next to continue.

### Step 5
Verify that the information is correct on the Completing the New JMX Server Wizard panel, and then click Finish to complete the procedure.

### Creating Web Target

If you want to configure Process Orchestrator to monitor the Central Management Server URL availability, you need to create a Web target and then reference it in the BOBJ XI target properties.

See Creating Web Target, page 4-23 for instructions about creating a Web target.

### Configuring References to Targets

You must now configure the BOBJ XI target to reference the JMX target and Web targets. Use the Target Properties feature to reference the targets.

### Creating Reference to BOBJ XI JMX Target

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Override URL Path</td>
<td>Check this check box if you want to override the default URL path and enter a different URL path to the JMX server. For example, service:jmx:rmi:///doc-bobj-xidev:9090/jndi/rmi://doc-bobj-xidev:9090/doc-bobj-xidev:6400</td>
</tr>
</tbody>
</table>
| Credentials of the following runtime user | Choose the user account that contains the credentials to connect to the target from the drop-down list.  
- To view the properties for the selected runtime user, click the Properties tool.  

### Field Description

<table>
<thead>
<tr>
<th>Step 4</th>
<th>Step 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Next to continue.</td>
<td>Verify that the information is correct on the Completing the New JMX Server Wizard panel, and then click Finish to complete the procedure.</td>
</tr>
</tbody>
</table>

The JMX Server displays in the Targets pane.

### Creating Web Target

If you want to configure Process Orchestrator to monitor the Central Management Server URL availability, you need to create a Web target and then reference it in the BOBJ XI target properties.

See Creating Web Target, page 4-23 for instructions about creating a Web target.

### Configuring References to Targets

You must now configure the BOBJ XI target to reference the JMX target and Web targets. Use the Target Properties feature to reference the targets.

### Creating Reference to BOBJ XI JMX Target

<table>
<thead>
<tr>
<th>Step 1</th>
<th>On the Definitions workspace, click Targets.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Right-click the BOBJ XI target and choose Properties.</td>
</tr>
<tr>
<td>Step 3</td>
<td>On the BOBJ XI Service Target Properties dialog box, click the BOBJ XI tab.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Select the BOBJ XI JMX Target property and click Edit.</td>
</tr>
<tr>
<td>Step 5</td>
<td>On the Target Property Value dialog box, click the Browse tool next to the Value field.</td>
</tr>
<tr>
<td>Step 6</td>
<td>On the Select Target dialog box, select the JMX Server target and click OK.</td>
</tr>
</tbody>
</table>
Creating Reference to BOBJ XI Web Target

Step 1  On the Definitions workspace, click Targets.
Step 2  Right-click the BOBJ XI target and choose Properties.
Step 3  On the BOBJ XI Service Target Properties dialog box, click the BOBJ tab.
Step 4  Select the BOBJ XI Central Management Console Web Target property and click Edit.
Step 5  On the Target Property Value dialog box, click the Browse tool next to the value field.
Step 6  On the Select Target dialog box, select the Web target and click OK.
Step 7  If you have completed adding target references, click OK to close the BOBJ XI Target Properties dialog box.
Configuring Assignments and Notifications

Task rules are used to manage task assignments and notifications for tasks, such as incidents and alerts, that are generated from processes. When you import the Core Automation for SAP automation pack, you are prompted to specify the default user or group who should be assigned SAP incidents. By default, this person will receive all assignments unless task rules are created to specify alternate users or groups for specific tasks.

Use the Definitions—Task Rules view to access, view, and configure assignments and notifications.

This chapter guides you through configuring task rules that ship with the automation packs and provides instructions for creating and managing task rules. It includes the following sections:

- Configuring SAP Default Assignment Task Rule, page 5-2
- Creating a New Task Rule, page 5-3
- Enabling Notification Based on Assignment Processes, page 5-7

Note

If you do not want to create task rules for email notifications, you can use the default notification based on assignment processes that ship with the Core automation pack. These processes are disabled by default and must be enabled if you want notifications to be sent (see Enabling Notification Based on Assignment Processes, page 5-7).
Chapter 5     Configuring Assignments and Notifications

Configuring SAP Default Assignment Task Rule

The Core Automation for SAP automation pack ships with the Default SAP Assignment task rule, which is used to specify the default user or group who will be assigned all SAP-related incidents unless otherwise specified in task rules. This task rule can be configured during the import process (“Default Incidents Assignee Setup Panel” section on page 3-4) or from the Task Rules view in the Console.

Step 1  In the Definitions workspace, click Task Rules in the navigation pane to display the task rules in the results pane.

Step 2  Click the Filter by link and choose Automation Pack, and then choose Core Automation for SAP from the drop-down list to display the task rules that ship with the automation pack.

Step 3  Right-click the SAP Default Assignment task rule and choose Properties to open the SAP Default Assignment Properties dialog box.

Step 4  Click the Assign tab to specify the user or group that should receive assignments for incidents and alerts generated by the processes.

Step 5  On the Assign tab, click Add to open the Select Assignee to Add dialog box.

Step 6  On the Select Assignee to Add dialog box, specify the assignees using one of the following methods:

- Click the Reference tool to select the appropriate variable reference containing the assignee or list of assignees from the Insert Variable Reference dialog box.
- Click the Browse tool to launch the Select User or Group dialog box to add user to the list of assignees.

Step 7  Click OK to add the assignee to the task rule.

Step 8  When you have completed adding assignees to the task rule, click OK to close the dialog box.
Creating a New Task Rule

Use the Task Rules view to create a new task rule. The procedure is the same for all types of task rules with the exception of the task-specific tab (Assign, Notify, Update) for the type of task rule you are creating.

**Note**
Only users with administrative rights can create task rules in Process Orchestrator.

You can create the following types of task rules:

<table>
<thead>
<tr>
<th>Task Rules</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign Task Rule</td>
<td>Assigns users to a task.</td>
</tr>
<tr>
<td>Notify Task Rule</td>
<td>Notifies users that a task has been created.</td>
</tr>
<tr>
<td>Update Task Rule</td>
<td>Specifies the properties to be updated in a task.</td>
</tr>
</tbody>
</table>

**Step 1**
In the Definitions workspace, right-click **Task Rules** and choose **New > [Task Rule Type]** to open the New Rule Properties dialog box.

**Step 2**
On the General tab, enter the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name of the task.</td>
</tr>
<tr>
<td>Type</td>
<td><em>Display only.</em> Shows the type of object.</td>
</tr>
<tr>
<td>Trigger</td>
<td><em>Display only.</em> Type of trigger associated with the task rule.</td>
</tr>
<tr>
<td>Owner</td>
<td>User name of the owner of the task rule. This is typically the person who created the task rule. Click the <strong>Browse</strong> tool to launch the Select User or Group dialog box to change the owner.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the task rule.</td>
</tr>
<tr>
<td>Enabled</td>
<td>The check box is checked by default to indicate that the task rule is available for execution. Uncheck the check box to disable the task rule. If the check box is unchecked, the task rule is disabled and will be unavailable for execution.</td>
</tr>
</tbody>
</table>

**Step 3**
Click the **Task Types** tab to specify the types of tasks to be executed by the rule.

**Step 4**
Check the check box for the type of task that will execute the rule.

<table>
<thead>
<tr>
<th>Task Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert</td>
<td>Alerts reflect potential problems that a user may want to investigate and possibly diagnose the problem.</td>
</tr>
<tr>
<td>Approval Request</td>
<td>Specifies the message and choices for the assignee who is approving the task.</td>
</tr>
<tr>
<td>Guided Operation</td>
<td>Details the steps a user takes to complete an assigned task.</td>
</tr>
</tbody>
</table>
Creating a New Task Rule

Step 5  Click the **Conditions** tab to specify the conditions of when the task rule action is to be taken based on an evaluation of the defined conditions.

Step 6  On the Conditions tab, define the conditions that must be met for the rule to execute.

**Defining a Basic Condition:**

a.  On the Basic page, click **New** to add a new property for the condition that must be met.

b.  In the Property text field, click the **Reference** tool to choose a defined variable or reference an object on the Insert Variable Reference dialog box.

c.  Choose the condition expression from the drop-down list.

d.  Enter the condition description in the text box or click the **Reference** tool to choose a defined variable or reference an object on the Insert Variable Reference dialog box.

e.  Click **New** to define additional properties, if necessary.

**Defining an Advanced Condition:**

a.  Click the **Advanced** tab to define a specific type of condition (Compound, Prior Process Instance, Time, or Variable).

b.  Click the link to modify the option for the condition equation.

c.  Click **New** and choose the type of condition from the drop-down list.

d.  Specify the relevant information for the type of condition selected.

**Note**  Click the **Reference** tool to choose a defined variable or reference an object on the Insert Variable Reference dialog box.

e.  Click **New** to define additional properties, if necessary.

Step 7  Click the task rule specific tab (**Assign**, **Notify**, or **Update**) and specify the relevant information for the specific type of rule.

<table>
<thead>
<tr>
<th>Task Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Task requires an operator to take action in order to resolve an issue.</td>
</tr>
<tr>
<td>Input Request</td>
<td>Task requires input from an individual or group.</td>
</tr>
<tr>
<td>Review</td>
<td>Task assigns a document for review.</td>
</tr>
</tbody>
</table>

---

**Task Type Description**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND condition (all conditions must be met)</td>
<td>Click this option if an action is to be taken only when all conditions in the list are <strong>true</strong>.</td>
</tr>
<tr>
<td>OR condition (one condition must be met)</td>
<td>Click this option if an action is to be taken when one condition in the list is <strong>true</strong>.</td>
</tr>
</tbody>
</table>
Assign Task Rule
If you are creating an Assign Task Rule, the Assign tab displays on the New Rule Properties dialog box.

On the Assign tab, specify the assignees for task rule.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click this button to launch the Select Assignee to Add dialog box to specify the assignees. On the Select Assignee to Add dialog box, use one of the following methods to specify the assignee:</td>
</tr>
<tr>
<td></td>
<td>• Click the Reference tool to select the appropriate variable reference containing the assignee or list of assignees from the Insert Variable Reference dialog box.</td>
</tr>
<tr>
<td></td>
<td>• Click the Browse tool to launch the Select User or Group dialog box and add user to the list of assignees.</td>
</tr>
<tr>
<td>Edit</td>
<td>Select the appropriate assignee in the list and click this button to view or modify the assignee of the task rule.</td>
</tr>
<tr>
<td>Remove</td>
<td>Select the appropriate assignee and click this button to remove the assignee from the list.</td>
</tr>
<tr>
<td>Remove All</td>
<td>Click this button to remove all specified assignees from the list.</td>
</tr>
</tbody>
</table>

Notify Task Rule
If you are creating a Notify Task Rule, the Notify tab displays on the New Rule Properties dialog box.

On the Notify tab, specify the recipients of the notification that the task rule has executed. You can add individual recipients or include a notification recipient list.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add notification recipients</td>
<td>Displays list of users to be notified by the task rule.</td>
</tr>
<tr>
<td></td>
<td>• Add—Click this button to launch the Select Notification Recipient to Add dialog box to specify the recipients.</td>
</tr>
<tr>
<td></td>
<td>• Edit—Select the appropriate recipient in the list and click this button to view or modify the recipient of the task rule.</td>
</tr>
<tr>
<td></td>
<td>• Remove—Select the appropriate recipient in the list and click this button to remove the recipient from the list.</td>
</tr>
<tr>
<td></td>
<td>• Remove All—Click this button to remove all specified recipients from the list.</td>
</tr>
<tr>
<td>Edit</td>
<td>Select the appropriate assignee in the list and click this button to view or modify the assignee of the task rule.</td>
</tr>
<tr>
<td>Remove</td>
<td>Select the appropriate assignee and click this button to remove the assignee from the list.</td>
</tr>
<tr>
<td>Remove All</td>
<td>Click this button to remove all specified assignees from the list.</td>
</tr>
</tbody>
</table>
Creating a New Task Rule

If you are creating a new task rule, the ‘Add’ tab displays on the New Rule Properties dialog box. On the ‘Add’ tab, specify the properties to be updated after the task rule has executed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add notification recipient list</td>
<td>Click the Reference tool to select the appropriate variable reference containing list of recipients from the Insert Variable Reference dialog box.</td>
</tr>
</tbody>
</table>

Update Task Rule

If you are creating an Update Task Rule, the Update tab displays on the New Rule Properties dialog box. On the Update tab, specify the properties to be updated after the task rule has executed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Click this button to add a new property to the Properties to update area.</td>
</tr>
<tr>
<td>Remove</td>
<td>Click this button to remove the last property added to the Properties to update area.</td>
</tr>
<tr>
<td>Property</td>
<td>From the Property drop-down list, choose the item to update within the task. The properties displayed depend on the selected item.</td>
</tr>
<tr>
<td>List action</td>
<td>Choose the appropriate item from the drop-down list to determine which action to take with the selected property:</td>
</tr>
<tr>
<td></td>
<td>• Add Item—Adds item to task.</td>
</tr>
<tr>
<td></td>
<td>• Remove item—Removes item from task.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter new value for the property.</td>
</tr>
</tbody>
</table>

Step 8

Click OK to save the task rule definition and close the dialog box.
Enabling Notification Based on Assignment Processes

If you want to have emails sent to whoever is assigned to a task but do not want to create notification task rules, you can enable the processes that ship with the Core automation pack that send emails based on assignment.

When these processes are enabled, the user or user group who was assigned to tasks will receive the email notification.

**Step 1**
In the Definitions workspace, click **Processes**.

**Step 2**
Click the **Filter by** link and choose **Automation Pack > Core** to filter for the processes that ship with the Core automation pack.

**Step 3**
Right-click the appropriate **Notification Based on Assignment** process and choose **Enable**.

The following processes are for notification based on assignment:

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Alert Notification Based on Assignment</td>
<td>Sends email when an alert gets assigned.</td>
</tr>
<tr>
<td>Default Approval Request Notification Based on Assignment</td>
<td>Sends email when an approval request gets assigned.</td>
</tr>
<tr>
<td>Default Change Request Notification Based on Assignment</td>
<td>Sends email when an change requests gets assigned.</td>
</tr>
<tr>
<td>Default Guided Operation Request Notification Based on Assignment</td>
<td>Sends email when a guide operation request gets assigned.</td>
</tr>
<tr>
<td>Default Incident Notification Based on Assignment</td>
<td>Sends email when an incident gets assigned.</td>
</tr>
<tr>
<td>Default Input Request Notification Based on Assignment</td>
<td>Sends email when an input request gets assigned.</td>
</tr>
<tr>
<td>Default Review Request Notification Based on Assignment</td>
<td>Sends email when a review request gets assigned.</td>
</tr>
</tbody>
</table>
Configuring SAP Global Variables

The SAP processes use global variables for information that is used on a regular basis to avoid having to specify the same information in several processes or activities. Some of the variables that ship with the automation packs are configured with default values but can be modified to meet the requirements for your specific environment. Other variables do not have default values defined and must be defined by the user before it can be used in the processes.

Use the Definitions—Global Variables view to access and manage global variables that ship with the automation packs.

This chapter provides information on configuring global variables. It includes the following sections:

- Configuring Global Variables, page 6-1

### Configuring Global Variables

If the automation pack ships with global variables, you must configure them before they can be used in the processes. This section guides you through configuring a global variable.

**Step 1**
In the Definitions view, click **Global Variables** in the navigation pane to display the variables in the Global Variables pane.

**Step 2**
Click the **Filter by** link and choose **Automation Pack > [Automation Pack Name]** to filter for only the global variables that ship with a specific automation pack.

**Step 3**
In the Global Variables pane, right-click the global variable and choose **Properties**.

**Step 4**
In the Value text field, enter the number of seconds to suppress duplicate alerts and click **OK**.
INDEX

A
ABAP application server  4-3
ABAP system connection information  4-4
about
  configuring SAP Solution Manager targets  4-10
  configuring SAP system targets  4-3
accessing
  global variables  6-1
access rights
  DB2 database  2-17
  Oracle database  2-16
  SAP User account  2-10
assignments and notifications  5-1
assign task rule, creating  5-3, 5-5
Automation Pack Import Wizard
  launching  3-1

C
configuration requirements  2-10
configuring
  SAP Solution Manager targets  4-10
  SAP System targets  4-3
connection information
  ABAP system  4-4
  JMX Server  4-26
  SAP database  4-5
Connection properties, Unix/Linux System  4-16
connection string  4-6
creating
  assign task rule  5-3, 5-5
  notify task rule  5-5

update task rule  5-6
credentials
  ABAP system, specifying  4-4
  JMX Server, specifying  4-26
  SAP database  4-5
  SAP User  4-8, 4-9

D
DB2 database, access rights  2-17
default
  runtime user, specifying  4-5, 4-11, 4-24, 4-27
defining
  runtime user  4-9
  SAP Solution Manager targets  4-10
  SAP System targets  4-3
  SAP User  4-8

E
email notifications  5-1
enabling
  notification based on assignment processes  5-7

G
global variables
  accessing  6-1

J
Java application server  4-3
JMX Server
connection information 4-26

M
message server, specifying 4-4, 4-11
monitor
  ABAP application server 4-3
  Java application server 4-3
  SAP database 4-3
  server availability 4-5, 4-12

N
notify task rule, creating 5-5

O
Oracle database, access rights 2-16

P
processes
  notification based on assignment 5-7
product default settings
  SAP ABAP System 2-11

R
router string, specifying 4-5, 4-11
runtime user records
  defining 4-9

S
SAP database 4-3, 4-5
  connection, specifying 4-5
SAP Solution Manager target
  defining 4-10
SAP system number 4-4, 4-11
SAP System target
  defining 4-3
SAP User
  credentials, specifying 4-8, 4-9
SAP User, defining 4-8
SAP User account
  access rights 2-10
server availability
  specifying servers 4-5, 4-12
  specifying
    application servers, availability monitoring 4-5, 4-12
    default runtime user 4-5, 4-11, 4-24, 4-27
    message server 4-4, 4-11
    router string 4-5, 4-11
    SAP database connection information 4-5
    SAP system number 4-4, 4-11
    SAP User credentials 4-8, 4-9
SQL Server Windows Authentication 2-14

T
task rules 5-1
  assign 5-3
  conditions 5-4
  General properties 5-3
  task types 5-3

U
Unix/Linux System Connection properties 4-16
update task rule, creating 5-6
user accounts
  DB2 database 2-17
  Oracle database 2-16
  SAP 2-10
verifying user rights
  SAP User Account  2-10